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Leave the bulky music portfolio at home.

Introducing the paperless music library.®

The MusicPad Pro® Now you can travel light.

i 999. ) . _—_
i Stacks of sheet music, heavy binders and loose rehearsal notes weighing you down? Relax.

(stand not included) The MusicPad Pro® is here and it will replace all your printed sheet music. You can scan paper scores,
import music from all the popular music and graphics programs or download music from the Internet
into this user-friendly, 12.1-inch tablet-sized digital music reader.

Compose or make rehearsal notations right on the page of music and then store, change or delete your
marks as needed - all while saving your original score. In fact, you can store up to 5,000 sheets of music*
And turning the page is a snap. A quick touch on the screen or tap on the optional foot pedal will turn
the page for you. You may never miss a note again. And your days as a beast of burden are over.

*5,000 page storage capacity available with the MusicPad Pro® Plus. ©2003 FreeHand Systems, Inc. All rights reserved. '
MusicPad Pro® and MusicPad Pro® Plus are trademarks of FreeHand Systems, Inc.
@

TM

Sheet music for the digital age.® FreeHand

Discover the new look in sheet music. Call 1.800.503.9697 or visit www.freehandsystems.com today.
i




One of music’s most prolific producers,
CMA- and Grammy®-Award-winner Tony
Brown (right) has produced more than 100
albums, and lists amang the beneticiaries of
fhis talents such names as Lyle Lovett, Trisha
Yearwood, Reba McEntire, Vince Gill, George
Strait, Jimmy Buffett, and Steve Earle. Now,
as senior partner of Universal South < _

Records, he helms the careers of up-and- :
coming artists like Joe Nichols, Amanda

Wilkinson, and Bering Strait.

Producer/engineer and digital pioneer
Chuck Ainlay has worked steadily as one
of Nashwville’s top pro audio leaders for artists
as diverse as George Strait, Willie Nelson,
Mark Knopfler, Emmylou Harris, Vince Gill,
Reba McEntire, Trisha Yearwood, Steve
Earle, Lyle Lovett, Peter Frampton, and
Everclear. in the process, he's collected
numerous awards and accolades, including
several Grammy nominations.

3
.

e ————

For decades, these two professionals have
lent their signatures to top artists across the
musical spectrum, and Audio-Technica 40
Series mics are part of that signature.
According to Chuck, “I've been using 40
Series mics ever since the 4050 was first
introduced. | immediately discovered its
flexibility and suitability for whenever |
needed a crisp, detailed sound. The 40

Series range has continued in this direction.
| wouldn't go into the studio without them” 4 O) S E R l E S
Take the adwvice of a couple of Nashville
legends and make a 40 Series microphone
part of your unique signature. Who knows?

You may just be making musical history—
like they have.

Special thanks to Sound Stage Stuthos, Nashwille, TH audio-technicaw

Audio-Technica U.S,, Inc. | 1221 Commerce Drive, Stow, OH 44224 | 330.686.2600 | Fax: 330.686.0719 | E-mail: pro@atus.com | www.audio-technica.com
World Radio History 4
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MOTU 828mklil

FireWire audio/MIDI interface,
synchronizer, mixer

Yamaha 01V96

Digital mixer

Sony Pictures Vegas 4 e
Audio/video software for PC
Roland M-1000

Rackmount digital mixer
Apogee Big Ben

192 kHz master word clock

Hot House ARM 265

Aclive nearfield monitors
Aurora Audio GTQ2

Stereo mic preamp

Universal Audio
Compressor Bundle

Vintage compressor TDM plug-ins
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CD/DVD duplicator
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Coming Attractions
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Vienna Symphonic MIR

Multi-lmpulse Reverb

COLUMNS

Across the Board
by Roger Nichols
AES, DAWSs, and docs
Session @
by Lisa Roy
Drums with Blink-182

Power App Alley

Cakewalk Sonar
Add “freeze” functionality

Steinberg Nuendo 2.0
Simultaneous tracking with and
without effects

Emagic Logic Audio
Music for picture




ier constitutes a claim of the trademarks by BEHRINGER® nor affiliation of the trademark owner with BEHRINGIR®
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ADAT* and its respective logo are registered trademarks of their respective owner. Their use neith

* hardware channels and not virtual channels

The world’s most affordable
digital 32-channel” mixer-.

Contact your dealert

ver@acra  aovm | ama@any | wes | vomn @ wime | mpen | seoan@rvowr | ausmw | vucan@snom | ywoay | vwonn @ sase
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DANALOG DDX3216—all the advantages of an automated digital mixing console—with an analog feel.

The DANALOG DDX3216 is more affordable than ever before. You get a professional digital mixing console with
first-class features and optional accessories such as ADAT®, AES/EBU and TDIF cards. The best of all,
it's as user-friendly as an analog mixer-it's Digital but with an Analog Feel. Now it's time for you to go digital.

The ADASO0O option (avallable 3rd quarter 2003) adds 8 extra IMPs
(Invisible Mic Preamps) to the 12 already built-in for a total of
20 premium mic preamps, Expandable to 28 IMP mic preamps

with a second ADAS00O.

4 powerful FX processors
accessible from all 32 channels

32 channels, 16 busses. 8 aux
sends, fully parametric EQs, super-
fast motorized faders and awesome

automation options
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12 studio-quality State-of-the-art 24-bit A/D and D/A converters
Invisible Mic Preamps (IMPs) for highest resolution and extremely low noise

Now it’s time for you to go digital.

www.behringer.com /@\

Or get more detalied proauct information, press reviews, awards and a list of endorsers!

BEHRINGE!

sla +65 6542 9313 - Australia +61 3 8877 7170 - Canada +1 902 860 2677 - Europe +49 2154 9206 4166 - Japan +81 3 3291 7401 - USA +1 425 672 0816 JUST LISTEN.
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DVD-A VERSUS SACD

As the state of California finds itself embroiled in a gubernatorial
crisis, the online forum dwellers of the recording world have
other debates on their minds: Mac-vs-PC, AU-vs-VST, analog-vs-
digital, commercial-vs-project studio. The threads are heated and,
in some cases, counterproductive. But today, on the verge of the
115th AES convention, we turn our attention to one particularly
important topic: Which of the emerging high-definition audio
delivery standards will eventually unseat the mighty 16/44.1
CD? Will it be DVD-A, SACD, or neither?

As hot as the topic is today, the roots of the debate
actually trace back nearly five years. In 1999, Bobby Owsinski
penned a revealing article in EQ about the state of the
technology, and the ins and outs of each format {see www.
surroundassociates.com/newformats.htmi}. Mitch Gallagher
revisited the topic in our June 2003 “Future-Proof Studio”

DVD-A and SACD require new-generation hardware for
playback, which could be considered a setback to some
consumers, but the good news is that an increasing number of
new DVD players are equipped to handle both formats. A bigger
concern is whether the almighty marketing machine of the
recording industry is focused enough to push the topic into
mainstream awareness. As one astute MusicPlayer forum
member posted: “The RIAA is spending too much time
worrying about illegal downloads when it should be establishing
the formats of tomorrow. DVD-Audio or SACD in 5.1 should be
advertised heavily.”

We all witnessed the “morphing” effect in the video world
as the balance of retail inventory shifted from VHS to DVD titles.
How long before we see the same transition in music? One
thing is certain: If 5.1 becomes the de facto playback system in
cars, look for an explosion in surround titles. And how will the iPod
revolution play into this? Will hi-def audio find its way to these
portable devices along with surround headphone technology? |
say bring it on, and soon!

Much of this month's feature section is devoted to another hot
topic — audio-for-video — but don't overlook a smaller but equally
important feature on DVD-A written by multimedia masters Studio
Voodoo. And there's more to come, as future articles from the
team will dive deeper into the new-format waters.  —Greg Rule

The BAND STAND

What new piece of gear or technology would you like
to see at AES?

f

Greg Rule, Mitch Gallagher, Craig Anderton, John Krogh,
Executive Editor Editor Editor at Large Technical Editor
Is the wireless studio Still waiting for the I'd like see a “viny! An audio/MIDI

a pipe dream? ultimate control scanner” — you put interface for

Imagine one honkin’ surface .. one that a vinyl record on the connecting multiple
wireless hub that lets you transparently “scanner” it follows 1 computers together,
connects a studio’s access everything in a the grooves optically, } the software driver
worth of gear — program without and generates a would handle

mics, monitors, locking at a screen corresponding {ransmitting data
DAWS, mixers, Then we can get back to waveform that you to/from each
processors, mixing, editing, and can capture to your computer, mimmizing
peripherals. Goodbye processingwithourears 3 computer latency and
spaghettt nstead of owr eyes ' duplicated hardware.
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Focused. Instrumental. KSM.

There's more than meets the
eye to the ncw instrumental
KSM studio <condenser
microphones from Shure.
There's performance. heritage
and versatility. The dual-
pattern KSMI41 switches from
cardioid to omnidirectional
with the turn of a dial
The studio-workhorse KSM137
powers through percussion
and soars with the solos.

www.shure.com

World Radie

Expeclations.

And the KSMIO9 rounds out
the KSM instrument line with
incredible price performance.
These microphones feature
transformerless preamplifier
circuitry. extended frequency
response, and incredibly low
self-noise. They provide the
technology. so your studio
can provide the sound. The
KSM line of instrument studio
microphones. Only trom Shure.

It’s Your Sdund



CO of the Month

Steely Dan

Everything Must Go, Warner Bros.
The opening lyrics of Steely Dan’s
latest might give listeners the
impression that Becker and Fagen
are throwing in the towel: "Attention
all shoppers, it's cancellation day;
yes the big adios is just a few
hours away.” Or on the closing
track: “Let’'s admit the bastards
beat us, | move to dissolve the
corporation in a pool of margaritas
But this legendary band i3 anything
but finished. The songs on
Everything Must Go are as clever
and witty as ever, and the production
and performances are up to the
gold standards the band set and
has maintained over their illustrious
three-decade career. As we've
come to expect from Steely Dan,
the lineup of Fagen/Becker sidemen
is ever evolving. One surprise this
time around, however, is the
debut of drummer Keith Carlock
who plays on every track. And for
good reason: His grooves are
deep and absolutely airtight. No
room for fudge on this CD; the
recording quality is bone dry and
pure. EQ columnist Roger Nichols
returns to the engineering chair
for this disc, along with Elliot
Scheiner, TJ) Doherty, and Dave
Russell. A must-have for all Steely
Dan fans and newcomers alike.
(www, steetydan.com)

EQ OCTOBER 2003 www.eqrmag.com

Punch-In

Tips & News You Can Use

BY GREG & CRRAIG & JOHN

News

GRAMMY WORKSHOPS

The San Francisco chapter of the Recording Academy recently hosted an all-star event called “Digital
Workstations from Garage to Grammys” at the legendary Skywaker Sound Scoring Stage just north of
San Francisco. The gathering gave attendees an intimate look at the tools and the technical processes
responsible for putting many of today's artists at the top of the charts. Featured engineers included Phil
Tan, Larry Seyer, and Jean-Marie Horvat; the exhibitors were Antares, Apogee, Apple Computer,
Cakewalk, C-Tec, Digidesign, Dynaudio, Emagic, Guitar Center Professional, Hear Technologies, KRK Systems,
Mackie, Monster, Presonus, Shure, Steinberg, Tannoy, TC Electronic, Universal Audio, and Waves.
This is just one of the many informative functions that the National Academy of Recording Arts &
Sciences hosts around the country. If you're interested in becoming a member, visit the NARAS site

at www.grammy.com.

s
Pictured (L to R): Event moderator Paul Stubblebine,
engineer Phil Tan, Executive Director Merl Saunders
Jr., engineer Larry Seyer, Skywalker Sound Director
of Music Recording and Scoring Leslie Ann Jones,
and engineer Jean-Marie Horvat.

Featured engineer PhilTan mixes an unreleased track
by Egyptian pop artist Hakim, with guest vocals by
James Brown, at his Pro Tools workstation.

ote

STEM SMARTS

At the end of a multitrack mix session, it's a good idea
1o make submixes {stems) as a means of delivering a
condensed version of the session to another facility, or
for safety backup purposes. Having audio stems in AIF
or WAV format ensures that you'll be able to retrieve the
multitrack material years later, no matter what version of
software or recording platform you're using at the time.

In creating stems, the choice of how to submix
{or not) 1s up to you. If space is an issue, perhaps
you'll want to submix the drums and percussion down
1o a stereo pair, all of the synths and keyboards to a
pair, and so on.

When bouncing each stem, always start from the
exact same location at the beginning of the song. That
way, all stems can be quickly loaded into your DAW of choice, aligned flush left, and you're good to go. When
picking your start point, you might want to aliow for a tiny bit of additional space before bar 1, beat 1, as a
safety precaution against accidental truncation. Also, you'll probably want to make two versions of each
stem, one with effects and one without.

And now for the most important stem-related tip: Bypass all master channel effects when bouncing, otherwise
you'll end up with a series of pre-mastered stems that might cause problems when multiplied together later on.

Grammy photography: Lynda Niemeier, Lynda Niemeier Photography; photo courtesy of the Recording Academy
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SECRETS
OFTHE
GRILLE
CLOTH
Here's a up from
producer/musi-
cian/angineer/
general all-around
good guy Jay
Graydon; If you're
racording a guitar
or bass amp,
remember that
the speaker’s
grille cloth, grille
cane, or metal
grille covers are
passive filters
that can affect
frequency
response. If
they're metal,
they can rning or
resonate; If
they're cloth or
cane, the vibration
may produce a
buzz that sounds
like a blown
speaker,

Grille cloth
exists 1o protect
the speaker,
aspacially when
transporting. If it's
easy to remove
while recording,
do so — the
sound will ba
bettar. Howeaver,
be very careful
not to let a mic
hit the exposed
speaker, Use a
sand bag to hold
the mic stand
base in place
and, if using 8
boom mic stand,
after positioning,
screw it down
ught,

Gadgetphile

Neumann KU100
Dummy Head Mic

A decapitated crash-test dummy? No, it's Neumann's KU100 Dummy Head
binaural stereo microphone. The head-like housing contains two microphone
capsules built into the ears. "When listening through high-quality headphones,”
says Neumann, “it gives the illusion of being right at the scene of the acoustic
events. The binaural stereo experience moves the listener into the scene of
the original performance, in contrast to other space-related recording techniques,
where the acoustic event is moved to the listener. When played back through
loudspeakers, the sound matches to a high degree that of conventional stereo
microphones, placed in the same position. However, a superior quality is
added, that of a distinct spatial depth perception.”

The KU100 uses transformerless circuitry with the advantage of high output
capability, fast transient response, and low self noise. The usual output
transformers are replaced by electronic circuits. "As with traditional transformers,’
says Neumann, "this technique ensures good common mode rejection, and
prevents RF interference that may influence the balanced audio signals.” The
KU100 can be operated with 48V phantom powering from an external power
supply unit, or from the built-in battery. At the bottom of the head is a switch
for the different power supply modes, as well as connectors for balanced and
unbalanced output signals. Inside the head are additional switches for 10 dB
attenuation, and the highpass filter. Balanced (XLR) and unbaianced (BNC)
outputs are provided.

The KU100 comes in a robust aluminum carrying case, together with an
external power supply unit, a 5-pin XLR cable, and an adapter cable that splits
the 5-pin XLR output into two 3-pin XLR connectors.

www.neumannusa.com

:
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TESTING ALBUM
SONG ORDERS

You‘ve just completed the
tracks for your new CD, and are
wondering whether the slow,
romantic ballad “Snot Puppies
from Hell” will transition
smoothly into that crowd-
pleasing uptempo number,
“Let's Disbar Some Lawyers”
As we all know, recording your
songs is just part of the story:
You have to decide which ones
to use, and their optimum
order, before you can release a
finished project.

One of the best tools for
doing this is a portable
MiniDisc. Record your music
onto an MD (if you have too
many tunes to fit, you can dou-
ble the recording time by
recording in mono). With MD,
you can place markers at the
beginnings of songs, and
rearrange the song order
effortlessly with a few button
presses to see what works best.
What's more, you can carry the
player around with you and see
if the urder feeis good while
you're, for example, cruising
through the supermarket,
hanging out on the beach, or
wondering why the connecting
flight from Chicago is three
hours late,

www.eqgmag.corm OCTOBER 2003 EQ



News

Four Become Two

A pair of key music industry acquisitions to report

M-Audio, named the "fastest growing company in MI” for two
consecutive years, announced their acquisition of Evolution
Electronics Ltd., a UK-based manufacturer of USB MIDI
keyboards and controllers. M-Audio acquired all Evolution
products, software, and intellectual property rights, along with
all other assets and liabilities of the company in exchange for an
undisclosed sum. Says Tim Ryan, CEQ of M-Audio, "We are
very excited about bringing M-Audio and Evolution capabilities
together. It is clear to us that this joining of forces will make a
sum greater than the parts.” The transaction makes M-Audio the
largest supplier of USB MIDI keyboards and controllers in the
world. "We're honored to join the M-Audio family,” says
Evolution founder Richard Watts, “and are looking forward to
extending our reach and vision to a new level” Watts, who built
the company over the past 20 years, will continue to be
involved within the enlarged group. Niels Larsen is now acting
as general manager of Evolution.

And how about this shocker? Adobe, the giant that brought
us Photoshop, lllustrator, Acrobat, InDesign, and other landmark
software technologies, announced that they've taken ownership
of Syntrillium. A statement on Syntrillium'’s site explains
“Adobe Systems announced an agreement to acquire the tech-
nology assets of Syntrillium Software, a leader in digital audio
tools. Syntrillium’s flagship product, Cool Edit Pro (pictured
above), will join the company's existing line of professiona
digital video products. Terms of the agreement were not
disclosed. ‘Cool Edit Pro has won recognition across the
music and video industries, and by teaming up with Adobe
we will be able to bring this complete multi-track recording
application to an expanded set of customers,’ said Bob
Ellison, president of Syntrillium. ‘Introducing Cool Edit Pro
into the Adobe family is great news for our customers, who
will benefit from the company's complementary product line
and commitment to delivering high quality products.” During
the transition, Syntrillium products can still be purchased
from the company’s website at www.syntrillium.com.

EQ OCTOBER 2003 www.eqrmag.com
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. Aswe peruse the inner recesses, nooks, and crannies of the web,
| we ‘re constantly flagging sites, news items, and useful tidbits

\4 that we feel will be of interest to you. Such as:

B www.rpmdirect.com

“The ultimate record industry
resource” is their mantra. For nearly
six years, RPM Direct has served
as an online meeting place for record
producers, engineers, mixers, and
producer management companies.
The RPM Direct website is accessed
by legions of producers, engineers,
A&R execs, music pubhshers, fitm
and TV musicmakers, managers and
more. "As we continue 1o grow as a
resoutce for a global commuruty of music protessionals,” says RPM,
remain dedicated to our mission ot praviding a nuly valuable service to qur
industry, while providing an egalitarian environment for companies and
individuals, large or small, famous or undiscovered.” While you're at the site,
be sure to register for the excellent monthly email newsletter — chock full
of valuable tips, industry news, and more.

. WP Dlsect News Hoadiees

i —=  H www.musicxp.net

= == Need DAW tips? Check out this site,

f S~ written and maintained by Robin
A Webb — a self-described “music

o Pl e technology enthusiast for over 26

years, a freelance journalist, a computer
programmer (C, C++), a keen musician,
and an expenenced Windows user {(XP
Pro, XP Home, NT, 2000, 98SE, 95, 3.1).
The tips on my site are things | have
discovered myself, or tips that I've
picked up from reading books or surfing
the 'net. I've tried all of the suggestions on this site myself and they have
certainly helped me. | have put a lot of effort and time into these pages, and
| hope that you find the information useful and that you improve your
audio system performance by following the tips and advice provided.”
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Tuning Windows XP for Audio/Music Appiications

gt gy |
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B www.unicornation.com

Users of anything MOTU wiil want to bookmark this
site immediately, and visit often. Network with a glob-
al army of passionate, knowledgable MOTU hard-
ware and software maniacs.

M http://home.btconnect.com/christopherg
s | surgessus S IS

2 & ® > 9 Vv ¢ © ¢

Looking for a free VSTi analog
synth emulator for your PC
{(Windows 98 and up)? Check |
out the Tecnos SUPERWAVE ;
P8. It features 8-voice polypho- | =g
ny, two oscitlators, 64 patch
memories, dual resonant filters,
modulation with routing options,
and poly/mono operation. It's
only about 1.4 MB, has that B
coveted “fat” sound, and 1s worth waaaay more than the download ttime
Get it quick before they decide to start charging for it!

d Radio Histo
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TRANSFORM YOUR SOUND.

FEATURING:

UNMATCHED QUALITY Robust, high quality, independent time INTEGRATION into the Pro Tools TDM "“Time-Trimmer Tool” for seamless
scaling and pitch shifting for “no hassle” processing and superior edit operation directly on your tracks.

audio quality.

CONTROL & DISPLAY OPTIONS Time, Tempo, Bars, Samples, SMPTE,
PARAMETRIC TOOL for easy off-line time/pitch scaling with a fixed ratio. ~ Feet & Frames, Pitch, Interval, Frequency. Express the source and

destination time and pitch the way you need to see them.
GRAPHIC TOOL for time/pitch scaling with variable automated ratios. P o

FOUR LINK MODES Unlinked, Time, Pitch, Strapped—allows you to easily

REAL TIME TOOL for immediate no-hassle real time pitch shifting. défiE thelralations betwasnpitetiand e raripUIGaAS

FOUR ALGORITHM MODES Sync, Smooth, Transient and Punchy for

optimizing the processing to your specific audio needs. WAVES-SYSTEM AUTOMATION allows extensive automation of

time/pitch manipulations in real time and graphic modes.

= wikE SoundShifter—Featured as part of the Waves Transform Bundle with:
TransX-A transient designer—for edge control
F
Morphoder-Vocoding and beyond — Saiey
: A : 20
Doubler-Doubling, Chorusing, add Dimension Maxx
“e2

14 DAYS DEMO AVAILABLE AT YOUR WAVES DEALER OR AT WWW.WAVES.COM
(HEADQUARTERS) Azreili Center, Tel-Aviv, 67011 israel, phone: 972-3-608-1656
(NORTH & SOUTH AMERICA) 306 W. Depot Ave., Suite 100, Knoxville] Terriessge:37917, phone: 865-546-6115, fax: 865-546-8445
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PC SETUP STRATEGY

If the idea of building a music PC from scratch sounds like too much work, but you'd still like to add
another PC to your studio for soft synths (see our August 2003 issue), here’s a suggestion: Buy a
pre-configured consumer computer from the likes of HP or Gateway and trick it out for music. A year
ago we wouldn’t have recommended it, but these days off-the-shelf computers offer just about
everything you'll need for a rockin” music machine. However, you might have to jump through a couple
of hoops to make it “studio ready.” For starters, most store-bought PCs come with a “crippled” BIOS
that won't let you change IRQ settings for PCI devices. This is no good. You might run into IRQ conflicts,
which will cause havoc with music applications that need access to whatever audio card you have.
Here's how to get around this:

1. Disable the built-in audio features of the motherboard from the BIOS setup. This should free
up an IRQ for use with your pro audio card.

2. Boot up the machine with PNP {plug and play) enabled {from within the BIOS). This will “shuffle”
IRQs around. When the machine boots into Windows, see which IRQ is assigned to your audio card
from within the Device Manager. It should be set to 5 or above. (If not, you may need to remove or
uninstall a hardware component that you won’t be using, such as a PCl-card modem.})

3. Reboot and go back to the BIOS. Now disable PNP and boot into Windows. The sound card’s
IRQ will now be “locked in.”

Once you've done this you'll want to tweak Windows XP for the best music/audio performance.
For details, visit www.musicxp.net, one of our featured Surfboard sites this month.

EQmag.com

Forum

EQmag.com Paosts of the Month

M [Addressed to moderator George
Massenburg.) Is there any chance of you giving
us your processors in native format, especially
now that Audio Units is coming to be. I'm sure
all of us serious non-PT users will appreciate the
chance. Just a hope. —The Blue Planet, Belgium

Answered by George Massenburg: Well, sure,
we'd do it if enough people ask for it. Now, if D g At St S, e g
you could just let me know how we'ré going to
protect it from hacking, we’'ll be all set.

B I'm into trance, techno, industrial, and a
few other heavier electronica styles. One thing |
want to know is how to get that nice punchy
kick that sounds so pure that | hear in a lot of

trance? —Ender

Answered by Eric Vincent: You may want to

try decreasing the kick's

the bassline live down there instead. Try that, Q Semgrtun v Sengutey
and if the kick sounds a little lost, start boosting "
it a bit at 2.9 kHz, for attack, or just turn up the
volume of the kick, Mixing is all about getting

) L aw Ogwn | swibywn
bt B s W s 8 st nd
St rr g o s b

T e e oy Yt s
e T e
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O The St Survems F veuon
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sub-100Hz energy. Let

o Somay bt o Bop et Swodnd e 104 Thsaos
e

the kick and the bass to dominate alternate yet

sympathetic regions of the audible frequency spectrum . .. in any style of music. Even the big $$$ pro
mixers struggle with this issue; it is the Pandora’s Box of pro-level mixing, and it requires Kung Fu,
lots of it. Every situation, every song requirés a uniqué and custom approach; there are no simple
turnkey formulas. There are quides, though. One is: The faster the tempo (and as such the more rapid
instances of kick drum), the less low octave energy the kick should have. It you think about that, it
makes perfect sense: The bass octave has a lot of energy, and too much of it will distort a mix. Trance
is very fast in tempo, agreed? So logic would suggest a highpass filter on the kick set to 80 Hz (that
means NO signal from the kick below 80 Hz). Instead, put that big phat synth bassline down there
below 80Hz. Remember, this is only a guide, but it could point you in the general direction of some
ass-gyrating noize. Hope this helps.
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CONTROL
PROTOCOL
To avoid having
your controls
make crackling
sounds, approxi-
mately once a
month flip all
switches, press
every pushbut-
ton, rotate any
controls, and slide
any sliders over
their full travel
several times
Many o1 these
parts hava self
WIpINgG contacts,
and using them
pravents oxidy
tion. The one
axception is
membrane
switches, which
are plastic {they
usually look flat,
or slightly dirns
nlad, and
require very lit-
tle pressure for
activation)
Becauss they're
hormaotically
sealed ond use
conduotive plas-
tic, they are not
as subject to oxi
dation problems
Jack contacts
also nead 10 bo
“worked," as
many jacks use
switch ng con-
tacts that can
oxidize. Plug and
unpluy plugs
sevaral timas Into
all jJacks not just
for the benafit
of switching
contacts, but
8150 10 keep the
various pins and
contacts tree of
gorrosion. This
1ip applies 10
patchhays 100
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*9/83. Dgislisgn 192 113, 192 Digital 1/0, 96 1/0, MIDI 146, PRE, Pro Tools! HD, Pro Tools| HD Accel, and SYNE 10 are trademirk: or Zesees trademarkn o Avd Teefnwloge, Ine., oF its smsichares or Exvomns. Al otner trotlemarks are the property of thewr

INTRODUCING

Supercharge Pro Tools’| HD with the new HD Accel PCI cards and put the fastest,
most powerful digital audio workstation to work for you. Take all of the power
of the fastest computer, accelerate it with Digldesign’s blazing new

dedicated hardware, and experience unstoppable creative freedom.

192 1/0

192 Digital 1/0 .~

.
. .
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e 1I/0

961 1/0
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_:WNC e , For more information on how you can accelerate
m your success, visit www.digidesign.com/hdaccel.
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MIDI 1/0 digidesign
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CHEAPO BALANCED/
UNBALANCED LINE
CONVERSION

Sure, you can convert between
the two by using a balanced-to-
unbalanced transformer, or &n
active balanced-to-unbalanced
converter. But in many cases,
wiring some special patchcords is
all you need.

Balanced output to unbalanced
input: Wire balanced pin 1 to
unbalanced ground, balanced pin 2 to
unbalanced hot, and leave balanced
pin 3 unconnected.

unbalanced
input

balanced
male XLR
output

Unbalanced output to balanced
input: Wire unbalanced hot to bal-
anced pin 2, and unbalanced ground
to balanced pin 1. Balanced pin 3
can usually be left floating, but also
try grounding it. i the sound is better
or louder, leave it grounded.

unbelanced
output l
balanced
Q female
XLR
input

You may need to adjust levels,
but most modern gear has level-
setting controls that can compensate
for any level differences.

BEAT THE HEAT

Heat is a big factor in shortening
component life. Today’s gear can get
pretty hot, so make sure everything
is well-ventilated. Locate your gear’s
ventilation holes, and make sure
they're unobstructed. In particular,
check the chassis bottom; if there
are vent holes, make sure the unit
isn't placed on a soft surface, and
that there’s enough room underneath
it for air to flow. In some extreme
cases, you may need to allow a
rack space between particularly
hot-running units.

News
FOND FAREWELLS

- W Sam Phillips, the man who discovered Elvis Presley, who

; founded the legendary Sun Records, and who helped usher in
rock and roll revolution, succumbed to respiratory failure last
July at age 80

In the summer of 1953, Presley went to the Sun studio to
record two songs for his mother's birthday. Phillips (far right in
photo) noticed him and offerod tho singer a recording contract.
Phillips produced Presley's first record in the 1954 that featured
“That's All Right, Mama." “God only knows that we didn't know it would have the response that
it would have,” Phillips said in 1997 "But | always knew that the rebellion of young people, which
is as natural as breathing, would be a part of that breakthrough. What there was a need for was a
rhythm that had a very pronounced beat, a joyous sound, and a guality that young people in
particular could identify with." By 1956, when Phillips sold Presley’s contract to RCA for $35,000,
the rock and roll craze had become a cultural phenomenon and a multimillion-dollar industry.

Phillips was elected to the Rock and Roll Hall of Fame in 1986. In 2000, the A&E cable
network ran a two-hour biography called Sam Phillips: The Man Who Invented Rock And Roll.
Many other awards and honors were bestowed upon Phillips over the years, including a
Grammy Trustees Award from the National Academy of Recording Arts & Sciences in 1992. To
date, eight Phillips-produced recordings have been inducted into the Grammy Hall Of Fame.

Phillips began in music as a radio station engineer and later as a disc jockey. He started
Sun Records so he could record both R&B singers and country performers. His plan was to
let artists who had no formal training play their music as they felt it — raw and full of life. The
Sun motto was “We Record Anything, Anywhere, Anytime."

He got out of the recording business in 1962 and sold Sun Records in 1969 to producer
Shelby Singleton of Nashville. The Sun studio on Union Avenue in Memphis s now a
tourist attraction.

In his later years, Phillips spent much of his time operating radio stations in Memphis and
in Alabama. He stayed out of the limelight except for some appearances at Presiey-related
events after Elvis’s death. "I'll never retire. |I'm just using up somebody else’s oxygen if |
retire.” he said in an AP interview in 2000. [Source: Associated Press]

B Rock music fans are mouming the loss of John Purdell, an accomplished
producer, engineer, songwriter, and musician who lost his battle with
cancer in July. John's illustrious career was decorated with major world
tours and/or hit records for industry icons as such Ozzy Osbourne,
Motley Criie, Alice Cooper, Poison, Foreigner, and others. Tragically,
John was just 44 at the time of his passing.

*John was a classically trained pianist, born in San Diego and raised
in Los Angeles,” according to his bio. "His professional career started in
high school when John landed a publishing contract and became a staff
writer for well-known producer George Tobin. John eventually made a
name for himself as a top session keyboard player. It was then that he auditioned for and
landed the keyboard gig for a world tour with Rick Springfield. Rick was at the peak of his
career and they played venues ranging from all the top television shows to sold out arenas.

“The mid '80s found John back in the studio where he met and began working with
world-renowned engineer Duane Baron and metal producer Tom Werman. John, Duane, and
Tom became a formidable industry production team, with a string of multi-platinum records
produced for Motley Crile, Poison, LA Guns, and Kix. John and Duane later began a successiul
run of hit records preduced for Heart, Foreigner, Alice Cooper, Cinderella, and most notably
Ozzy Osbourne’s best selling No More Tears album, on which John co-wrote the title song. He
also wrote three songs on Ozzy's Ozzmosis CD.

“In the mid "90s John released a solo CD and traveled the US doing radio and television
appearances. In the summer of 2000 he played keyboards and sang background vocals with
Foreigner on the Jukebox Hero tour. Most of 2002 was spent on the road with Cinderella and
Poison playing to sold-out venues all over North America and Canada”

“John probably had the biggest heart in Hollywood,” said John's brotherin-law and busi-
ness partner Bill Flowers. “He always found time for everyone." Pay respect online at

www johnpurdell.com/memorial.
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NEW! FW-1884

The only DAW control surface with
built-in FireWire audio-MIDI interface!

— [\ Assignable foot-
switch jack for punch-ins
or MIDI control.

— @I Eight analog
Cr outputs for

& (/Rands.asur

round sound matrices. <

Fourteen DAW short-
cut buttons including
Save, Revert, All Safe, -
CLR Solo, Marker, Loop, |
Cut, Delete Copy, b 2
p— Paste, ALT/CMD,

E) Undo, Shift and

—far

Channel strip rotary
encoders can be as-
signed to 8 Auxes or ===
Pan via keypad.

Eight chavmel stiips

with 100mm, touch-
sensitive motorized

faders, Mute, Solo and

ww  Select buttons, ¥
Pan, trim and -

= | accessto

core  CTRL.Your mouse
[ and keyboard will
== feel very neglected.

Eight channel inserts.——
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Eight channels of ADAT?
lightpipe 170 and stereo
S/PDIF inputs & outputs.

2.8 Extra Firewire
port so you
= can connect to
external hard disks or
daisy-chain to our Ft-8

=1 7 1,
2 2[%-P00® 'Y 'y

slejvlSIvIoK.
2l

expander.

R Word Clock in
L

7/ 7 and out for ac-

~7 curate sync with
computer systems.

. Four MIDI inputs
1 TQ and four MIDI

outputs for sound
generation and timing.

== 100mm,

‘G touch-sen-
sitive motorized Master
tader. Varoom!

—Eight balanced ¥4"/ XLR

analog Mic/Line inputs
/e, With studio-
1@. grade, high-

\ % headroom,
low-noise mic preamps
and switchable phantom
power. XLR Input 8 is

even switchable from
Mic/Line to Guitar level.

It’s an 18-input, 24-
bit/g6kHz* Firewire
audio I/0O box...and a
4-in/4-out MIDI inter-
face! And a fully-
mapped controller for
Digital Performer™,

Nuendo’, Logic™,

Sonar”

and Cubase™!

Why spend extra on
audio and MIDI I/O0
boxes? Our new three-
in-one FW-1884 has

everything you need to

maximize workstation
productivty in a single
intuitive tool. For far
less than the cost of a
piecemeal approach.

Fire up the FW-1884

at a TASCAM dealer or
visit our web site for
more information.

TASCAM

Add banks of eight
channel strips with
FE-8 expanders.———

Separate Phanes,
Monitor and Solo
(AFL/PFL) controls.

Weight-
ed jup/shullle

1 Ne

A NUDGE »  more
mouse-and-key-
board juggling:
Dedicated transpart
buttons plus Nudge,
cursor, In/Qut/Set,
Locate, function
and Bank Switch
keys.

TEAC

A

anniversary

Full 96kHz operation on all analog 170 channels with compatible DAW software
2003 TASCAM All Rights Reserved All features and spectficalions are subjecl Lo chiange
without notice Sonar 1s a trademark of Twelve Tone Systems. Nuendo and Cubase are
registered trademarks of Steinberg Media Technologies AG. Digital Performer 15 a trade
mark of Mark of the Unicorn Logic 1s a ttademark of Emagic/Apple Computers.
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Tool Box

BY KEVIN OWENS
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\Waves Transform Bundle Elum:
Hi-resolution sound transformation plug-ins e

Four 96 kHz compatible plug-ins comprise this powerful new bundle from Waves. Sound
Shifter allows shaping of time and pitch with the ability to pitchshift over an octave with
a time ratio of 50-200%. Doubler adds dimension and fattens up tracks with double-
tracking, exciter-style, and harmonization-type effects. TransX is for shaping attacks and
transients, controlling and shaping dynamics for punch without artifacts or that cliché
"over-squashed” sound. Morphoder takes the concept of vocoding and expands the
possibilities. It will create the classic voice effects of traditional vocoders, generate modern
electronic rhythm tracks, and more. The bundle is currently for DAE only, TDM ($2,400)
and Natlve ($1,200), on both Mac and PC platforms. Coming soon in other formats
Waves, www.waves.com

sounpbsircwcles

PrimeSounds Flum — Trips

and Tranceformations
Sample CO

Flum - Trips and Tranceformations ($99.95)
P is a Rex/WAV/Audio sample CD that the company
S P claims will “trip you out, trance you up,” and add new
w me m sonic dimensions to whatever type of dance music
Pt you're into. The audio/WAV/Rex format CD includes
lwo categories of sounds — Beats and Flum. Beats
offers hi-fi techno drum loops with lots of low end,
and Flum is a collection of creepy, futuristic, pulsating
background rhythms.

Hot House o e
Model Six Hundred

High resolution control room amplifier

The Model Four Hundred ($1,999), Six Hundred ($2,499 with line grain front panel; INPUTS
$2,698 with polished front panel), and Eight Hundred ($2,999 line grain; $3,198 polished)
control room amps feature drastically lowered output impedance in the mid and high frequencies, resulting in
improved clarity, definition, and musicality. The 3-rackspace Six Hundred (pictured) delivers 200 watts RMS at
8 Ohms and 275 watts RMS at 4 Ohms, has a frequency response of 3 Hz-180 KHz, and features Neutrik
combo XLR/TRS input jacks, and Cliff 5-way binding post outputs.

Hot House, www.hothousepro.com

M SEBOLATION CONTIKIL, ROM AMALIFER ~

CHAN. 1 SYERE

BALANCED  CHAN:
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PRO AUDIO LAB

PHASE ANALVZER Ultimate

Sound Bank

Soundscan2.com
Online sample library

Ultimate Sound Bank and llio
announced the launch of
wiwvwesoundscan2.com. The site/store
contains a searchable (and purchasable}
cataloy of the complete line of
Soundscan products, including
Soundscan Version 2, which supports
Audio, WAV, Acid, AIFF, Akai, EXS24,
HALion, MachFive, Reason2, and Rex 2
formats. Soundscan2 currently consists
of 11 volumes ranging from drum
loops to hip-hop production sets to

° . world libraries. Each product page
Ma C I e p rO H U I O l a features descriptions, demos, and
pricing information.

Ultimate Sound Bank, dist. by

08B audio measurement plug—in e wwwiie.com

Pro Audio Lab ($199; $169 download) is an audio measurement plug-in for
Mackie's Digital 8-Bus that provides a series of metering tools and gauging devices,
including stereo and mono level metering that displays peak, power, peak RMS,
correlation, sum and difference, loudness, and VU meters. The plug-in also featurcs
an octave selectable spectrum analyzer, a stereo X/Y phase meter, a phase scope, a
variable waveform oscillator, and a built-in tone generator that offers guitar, bass,
and piano reference tones.

Mackie, www.mackie.com

Raven Labs USIP

INnstrument preamp

The all-analog Unlversal Stereo Instrument Preamp ($949) features two independent channels
that can be used separately or in stereo. Each channel incorporates a 3-band semi-parametric EQ, sidechain
effects loop, phase switch, gain control, and has its own balanced XLR and line out. Other features include
phantom power on channel 2, overload indicators, effects blend controls, a mute switch, a ground lift
switch, and headphone, footswitch, and tuner jacks

Raven Labs, www.raven-labs.com
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RIRR Support
Pro-grade boom stands

Ideal for overhead recording applications, the
new AiRR boom stands feature a tripod base
with removable wheels, adjustable telescopic
locking legs with sturdy rubber feet, a sandbag
to add extra weight to the center of gravity,
fast locking and unlocking of the boom
angle, and a crank adjustment for height.
The AiRR 100 ($335) has a 5' base
and 7.5' boom arm, measuring 12.5'
when extended. The AiRR 200
($395) has a 6' base with an 8' boom
arm, and extends to 13.5', while the
AiRR 300 ($449) has a 6' base
with an 8' boom that measures 14’
when fully extended.
AiRR, dist. by Network
Pro Marketing, www,
networkpromktg.com/

airr_support.htm
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Sonic Stop
Hotbox Vol. 2

Drum loop library

Sonlc Stop’s Hotbox Volume 2,
Hip-Hop Drums ($34.95) is a collection
of loops and one-shots featuring hats, kicks,
snares, percussion, and effects performed
on an Akai MPC by Leo Cavallo. Hotbox 2
is available for Mac and PC, and supports
Reason Refili, Acidized wav 16/24-bit, and
Rex 2 sample formats.

Sonic Stop, www.sonicstop.com

ClearSonic
lsoFloor System

Modular isolation
platform

IsoFloor is a modular floor de-coupling system designed to
reduce drum sound and vibration transfer by approximately 6 dB.
By connecting several of the 2' x 2' ($40 ea.) or 1' x 1'
($30 ea.) baffles using the supplied Velcro connectors,
drummers and studio engineers can assemble a custom platform
that fits their needs.

ClearSonic, www.clearsonic.com
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SOFT SYNTH WORKSTATION

STUDIO-QUALITY
INSTRUMENTS & EFFECTS

PATTERN-BASED
SEQUENCERS & PROCESSORS

INTEGRATED ACID-COMPATIBLE
LOOPING TOOLS

The Next Step
Is Clear

REAL-TIME LIVE
PERFORMANCE FEATURES

Project5 is available at music retailers world wide.
Find out more at www.projectSstudio.com
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Planet Waves Bantam Cables
Patchcords

Planet Waves' patented Bantam Cables ($26.99-$99.99)
are TT (tiny telegraph) patchcords that feature ultra-fine stranded
quad conductors with oxygen-free copper shielding, dual insulation,
24-karat gold-plated plugs, and compression springs for a snug fit
The Bantams are available in two-, three-, and ten-foot lengths with
your choice of XLR or 1/4" connectors.

Planet Waves, www.planetwaves.com

CRD
Equitek? ,. , :
Carios Sennheiser Evolution

Condenser mics 1
The Equitek? Series ($TBA) consists 9 D O S e r | e S

of seven new Servo condenser mics
designed for studio and stage use: The 0 .

€502 and €602 instrument mics, the \/OCBI aﬂd lﬂStrumemt m | CS
€702 and 802 live performance mics,
and the 1002, €2002, and 3002
large condenser mics. The
supercardioid electret 1002
(pictured) features a fre-
quency response of 10-18
kHz, a dynamic range of
132 dB, total harmonic
distortion of less than

.16%, transformerless bal-
anced output circuits, and

an internal power reservoir
system. The €2002 shares the
same features but offers three
patterns (supercardioid, onmidirection-
al, and figure-8), while the e3002 sports
a large diameter (1.1°) externally biased
dual diaphragm capsule, and lets you
switch between cardioid, omnidirectional
and figure-8 patterns.

CAD, www.cadmics.com

Sennheiser’s new Evolution 900 series — launched at the Summer
NAMM show in Nashville — consists of two vocal mics and one
instrument mic. The two vocal mics — the cardloid
E935 ($279) and the super-cardloid E 945
($299) — feature shock-mounted capsules,
rugged metal casings, and stylish gunmetal
blue grilles. The E 903 ($289) cardioid
snare drum mic was designed to deliver
outstanding frequency response
while handling maximum sound
pressure levels.
Sennheiser,
www.sennheiserusa.com
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The Luna Microphone

Who says beduty is only skin deep? The new
M-Audio Luna professional condenser microphone
is truly a work of art inside and out. Luna delivers vintage
look and sound combined with modern electronics for the
best of both worlds. The large diaphragm cardioid design is

perfect for professionally capturing vocals, guitar, piano and just about
anything else. Whether you're looking for a great all-purpose first mic
or a fresh new sound for your microphone locker, Luna is the right micro-

phone at the right price (just $249 MSRP).

single-pattern cardioid condenser
large all-brass capsule O .

1.1 evaporated gold diaphragm

+/- 1dB tolerance across entire frequency range

Class A FET electronics

includes shock mount and hard case B

-

( @ ® ©  M-AUDIO

I www.m-audio.com
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RAKG K T & K 2731
Studio headphones

The K 171 ($199) and K 271 ($249) Studio headphones incorporate AKG's
Varimotion LLX transducers, patented gimbal ear cup suspension, and leatherette
headbands that conform to the size and shape of the user’s head. The closed-back K
171 Studio has a frequency range of 18-26,000 Hz, and weighs 7.1 oz without the
included 10-foot detachable cable. The 8.5-0z K 271 Studio (pictured) has a frequency
range of 16-28,000 Hz, and features a switch in the headband that mutes the audio as
soon as the headphones are taken off.

AKG, www.akgusa.com
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Furman Pro Plugs ®
Surge strips/bloc

Furman’s Pro Plugs ($20-%$49) line of surge strips, blocks, and
extension cords for performing musicians and recording studios consists
of four models, each with extended-length cords, and three, four, or six
outlets. A fifth model, the Laptop Travel Surge Tap, has three outlets and a
retractable phone cable. Each of the devices features EMI/RFI filtering to
eliminate distortion and hum, a circuit breaker, and a lighted on/off switch.
Furman, www.furmansound.com

Toft Audio ATC-2

2-channel compressor/EQ/mic pre

Designed by Trident Audio founder Malcom Toft, the 2-rackspace ATC-2 compressor/EQ/mic pre
($1,299.99) features two channels with switchable mic/line inputs, a D.}. input, 48 V phantom power, and a
phase switch. The AFC-2 also comes with a 4-band (low, low mid, high mid, high} EQ, a 50 Hz lowpass filter,
adjustable attack, release, and ratio parameters, FE.T. compression, two balanced XLR inputs, two balanced
1/4" inputs, two 1/4" instrument inputs, and a choice of balanced XLR or 1/4" outputs.
Toft Audio, www.toftaudiodesigns.com, dist. by PMI Audio Group, www.pmiaudio.com
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Any retailer can sell you
a piece of music geat...

Why buy from Sweetwater?

When you call Sweetwater, you not only get great prices on our huge inventory of the latest music technology,
you also gain access to a whole staff of experts who know that technology inside and out.

Unlike most retailers, our sales staff is filled with pro audio experts who have years of real world experience
using the gear we sell. Plus, our award winning Service Department can handle everything from putting
together custom configured music production systems to providing support and service for virtually every
product we offer.

Talk to one of our Sales Engineers today, or visit our web site and discover why so many musicians rely on
Sweetwater for a level of service that goes far beyond the gear.

Bigger Inventory. Better Prices. Best Service and Support.

Sweelwater (800) 222-4700

music technology direct> ~ WWIW.SWEGTWALEr.COM o pavmenrs

NO INTEREST

*Offer is subject to credit approval by Monogram Credit Card Bank of Georgia. Applies to any purchase made between 9/15/03 - 10/15/03 on a GECAF consumer credit card account. No finance |f pClId wathm

charges will be assessed on the promotional purchase amount {excluding optional insurance charges) if you pay this ameunt in full by the payment due date as shown on your 6th billing statement. .

It you do not, finance charges will be assessed on the promotional purchase amount from the date of purchase. Minimum monthly payments are not required on the promotional purchase during 6 MONTHS

the promotional pesiod. Il monthly minimum monthly payments on any other balances on your account (including optional insurance charges) are not paid when due, all special promotional terms Call us or signup online at:
may be terminated. Standard account terms apply to non-promotional purchases and, after promotion ends, to your promotional purchases. Variable APR is 21.98% as of 7/16/03 (in PR, fixed www.sweetwater.com/allaccess

APR is 22.48%). Except in PR, fixed APR of 24.75% applies if payment is more than 30 days past due. Minirnufs linance.coaaets $1(80 in PR). © 2003 Sweetwater, Inc. Valid 9/15/03-10/15/03




score with an AVV-equipped studio

producing music. And for most of us this means using a computer-based

digital audio workstation. No big shock there. More than just handling the
recording, mixing, and processing of audio, though, many DAWSs have evolved
into full-fledged audio-for-picture production tools that allow you to work with
digitized video right alongside your audio tracks. This isn’t surprising, considering
such developers as Digidesign, Steinberg, Sonic Foundry, and Emagic all have
direct ties to companies that make video editing hardware and software. Bottom
line: Video production has become just as accessible as digital audio production.

With this trend it has become apparent that there are new opportunities for
“music only” engineers and producers to enter the world of audio-for-video.
This could mean opening your studio doors to TV commercial work — creating
music, recording sound effects and voice-overs, etc. — or mayhe you'll go
all-out and offer video production services in addition to your audio work.
Countless bands and solo artists are no doubt in need of promotional
materials — who better to offer a one-stop shopping solution for promo
videos and DVDs than you?

Of course, lt's not yet time to say “Adios, audio.” But you don’t need Tarot
cards to tell you this is a multimedia world, whether we're talking CD-ROMs,
kiosks, video games, or you name it. The future belongs to studios that are
fluent in multimedia: There’s a crying need for industrial videos, tutorial and
training videos, streaming demos for the web, commercials, documenting
local events, and much more. There’s no reason why you can’t take advantage
of this to increase the flow of your income stream.

In this feature we look at two possible paths you could take into the
audio-for-video realm. On one hand, we'll explore working with video for TV
commercials, industrial videos, etc. On the other, we'll cover the entire process of
creating the video product yourself — everything from recording and digitizing
video to rendering and delivery format considerations. We also cover what
equipment you'll need to get started and even bring you behind the scenes of
two video-related projects to give you an idea of what you're in for.

Don’t worry, though — we're still EQ. We're not going to tell you how to
edit your video, but we will tell you how to work it into your audio world for
both fun and profit. Lights . . . camera . . . audio.

EQ OCTOBER 2003 www.egmag.com —John Krogh and Craig Anderton

I t's safe to say that if you're reading this magazine, you‘re into recording and




Getting Started With Video

by John Krogh

Equip your studio
for broadcast
applications

The biggest difference between composing music for
TV or films and other forms of musicmaking is the
incorporation of video equipment in the studio. For
musicians and other “audio types” who are just getting
into working with picture, it can be a confusing, frustrating
experience. You may already know that you'll need to synchronize
your music system to timecode (regardless of whether you use
a computer-based or stand-alone multitrack workstation). But
there are other issues, such as whether you'll need a video
patchbay, which frame rate(s) you'll be working at, and so on.
Unlike with Web and CD-ROM projects, the advertising, TV, and
film worlds still rely heavily on video tape. This is certainly changing.
as clients become more tech-savvy and more comfortable sharing
files with post production, sound design, and music houses via
computer servers. Even so, it's likely that you'll have to deal
with actual video tape at some point, so the first question is,
“"What kind of video deck do | need?”
In general, for broadcast work there are only three formats
you'll need to be concerned with. The type of video deck you
choose to go with depends on your budget, how much control

you like to have over the video playback, and whether your
clients expect or require you to work with a specific tape format:

VIDEO TAPE HARDWARE
1/2". Known in the consumer world as VHS, 1/2" tape is a
common format given to composers. You don't need a special
“pro” machine to work with 1/2" — a good-quality VTR from
Best Buy or The Good Guys is enough. Unlike the pro video
formats mentioned below, 1/2* doesn’t allow for timecode to
be written into the video or to a separate dedicated TC track.
U-matic. The standard format for 3/4" inch videocassette
recorders. 3/4" decks are capable of outputting timecode in
addition to the left and right audio channels. Syncing to a 3/4"
deck is a simple matter of connecting the deck’'s timecode
output to your MIDI interface’s SMPTE timecode input.
Betacam (or simply “Beta”). Beta is an old tape format,
but is still highly popular in the film and TV world because of its
picture quality, which some consider to be the standard by
which other formats are judged. As with 3/4" decks, Betacam
decks send timecode from a dedicated TC output.

These are by no means the only video formats out there, but
these are the ones you'll need to be aware of and be asked to work
with. There's one major advantage to working with Beta and 3/4":
Both formats support Longitudinal Time Code (LTC). Most
sequencers and higher-end MIDI interfaces support LTC.

You probably won't ever need one of each type of deck.

Initially, you can get by with a consumerlevel VHS

1/2°VRR

Audio Audio
Ch.L Ch.R
SMPTE
In —
MIDI interface —II
Mixer
Sequencer

When | want to sync my sequencer to a 1/2" tape, | ask the ad agency to put
the voice-over (VO) and any temp music/sound effects on one audio channel
of the tape, and record SMPTE timecode on the other channel. That way | can
route the timecode into my MIDI interface’s SMPTE input and monitor the other

audio el 1its of the cial as | p the music.

deck. New Beta and 3/4" decks will cost you thousands
of dollars, so if you don’t plan to use such decks often,
| recommend buying a used deck instead, since you
won't be putting rigorous demands on the machine the
way a video editor would. You can pick up used 3/4°
decks in the $500-$1,000 range, and used Beta decks
in the $1,000-$1,500 range.

DIGITAL VIDEO HARDWARE

In addition to these formats (1/2*, 3/4°, and Beta),
many composers and ad agencies have discovered
the virtues of working with digital video files. There
are several distinct advantages to working with digital
video, such as the convenience of not having to deal
with analog synchronization. The good news is, adding
digital video capabilities to your studio isn't difficult
or expensive.

Video Capture Devices. For many years now
there have been computer cards with video (and
audio) inputs and outputs, which let you capture, or
record, analog video signals with your computer, and
play back the digitized video file via the card’s analog
video outs. This allows you to view the file on aTV or
video monitor.

Mare recently, with the proliferation of FireWire-
equipped computers and digital video cameras, it has
become possible to record and play video from a
computer without having to use a dedicated capture
card, provided the computer is equipped with a

www.eamaag.com OCTOBER 2003 EQ
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Getting Started

FireWire (or IEEE-1394, sometimes also
known as i.link) connector.

FireWire can only be used to transfer
data — you still need some sort of device
to handle the digital to analog conversion.
Just about every digital video camcorder
made in the last two years can be used to
digitize analog video signals and transfer
the digital images to a computer via
FireWire. There are also interfaces, such as
Miglia's Director’s Cut Take 2
(www.miglia.com), that connect to your
computer via FireWire and let you capture
analog video/audio sources from RCA and
S-Video connectors. Going with this type of
box is cheaper than buying a DV camcorder,

Miglia’s Director’s Cut Take 2 is an IEEE-1394 video capture/output device that works
with Macs and PCs. It has analog video and audio connectors for capturing audio/video
with programs such as Apple’s iMovie.

and using a dedicated interface means you

don‘t have to keep your camcorder tied up in the studio. For more
on |EEE-1394 video capture, check out Craig Anderton’s Start-up
Guide on page 26.

SOFTWARE

Any pro digital audio workstation can be synced to SMPTE
timecode output from a video tape deck, so you shouldn’t
have to worry about buying a new DAW. You will, however,
need a video recording/editing program to capture clips for use
with your main host software. So long as the video program
lets you export the movie in a file format that can work with
your sequencer, you'll be fine. For more about video editing
software, check out Craig's guide.

You don't need to develop monster video editing chops; it's
enough to be able to trim the movie clip so it starts at the first
frame. This makes it easier to ensure that the movie begins
exactly on the downbeat of the first bar. If you're off by a few
frames, it can cause problems down the line when you send
your finished music track off to the post production house,
especially if your track is supposed to hit a bunch of specific
moments onscreen.

OTHER CONSIDERATIONS

It might seem obvious to most of us, but just to be thorough |
should point out that you'll need a MIDI interface with a SMPTE
input if you plan on syncing the DAW to a video tape. Now let’s
turn our attention to digital video.

Digital Video Advantages. Using digital video files has
several advantages: (1) Most MIDI/audio sequencers allow
you to open and play QuickTime or AVI movie files alongside
music tracks. This is a big deal, because it means you don't
have to worry about syncing your sequencer to an analog
timecode signal; (2) you don't waste time waiting for a tape to
rewind — you can instantly jump among locate points and the
video will follow; (3) all music and video files for a project are
stored in the computer, and can be recalled automatically when
you open a project in your sequencer. (Some programs save the
movie as part of the session, while others simply reference the
movie clip, so you may need to back up the video separately
from the audio.)

Managing CPU Resources. It takes a considerable amount
of DSP to play a video file along with music tracks, especially if

EQ OCTOBER 2003 www.egmag.com

you're using a PCl-based video capture card to play back the
movie to a TV monitor. If your music tracks consist mostly of
MIDI parts and a few audio tracks, you're less likely to have
problems playing back video files along with the music. But if
you tend to use a lot of audio tracks and effect plug-ins or software
instruments, you can quickly bring a computer to its knees by
adding video playback to the mix. Oftentimes as I'm scoring to a
QuickTime movie | reach a point at which the computer becomes
sluggish because of the burden of playing lots of audio tracks
along with video.

To avoid this, you can save the video clip to a data-compressed
format or a smaller frame size from within whatever video editing
software you have, resulting in a smaller, more easily streamed
file. Your computer will be less strained, but the video quality will
take a hit — a small price to pay for being able to run everything
from an overloaded DAW.

! Delivery Options. As a creator of music and audio for video
projects, you serve as one part in the “machine” responsible for
putting out a final product. During the course of a project, you
may be asked to present your work-in-progress to the producer,
director, editor, copywriter, etc. This means you'll need to record
your music onto a videotape (along with the original video) so the
client can see and hear it together. Alternatively, you'll need to do
the equivalent in software. Programs such as BIAS Peak and TC
Works Spark allow you to open a movie file and add new stereo
music tracks or replace the existing audio. Surprisingly, some
host programs don't offer this functionality.

MOVING AHEAD

It really doesn't take much in the way of hardware or software
to equip your studio for composing and producing audio for
video applications. What's more, the video-specific tools you'll
need are nowhere near as complicated as the average digital
audio workstation. If you can handle a pro audio program, you
can certainly get what you need out of a video editor without
too much head scratching.

There's more to this than the equipment, of course. Setting
up your MIDl+audio sequencer and actually creating sound
design and music for a video project has its own challenges.
To help demystify the process we've detailed two projects: a
one-minute commercial for TV broadcast and a three-minute
online industrial video.



NUENDO 2.0 MEDIA PRODUCTION SYSTEM

Introducing Nuendo 2.0 -
The professional solution

Nuendo 2.0 forms the core of a complete solution for today's audio
professional. Nuendo's superior audio quality is combined with advanced mixing,
routing, editing, and networking capabilites as well as professional components
such ag the new ID Controller, Time Base Synchronizer, 8 1/O 96k AD/DA
Convertors, and DTS and Dolby Surround Encoding Plug-ins. A system so
scalable - from laptop to installation - the choices are endiess
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2003 Stenbeg Media"l'e-c-hnologi&s GmbH. Al rights reserved.

Nuendo 2.0:

* A new configurable mixer, toolbar, and transporl control
* Mulliple 12 channel busses for “stem” monitoring up 1o 10.2
* Muttiple output configurations for multiple speaker set-ups

e

* Plug-in delay compensation throughout entire audio chain
» Flexible routing: any input to any output at any point

* Hyper-threading support for optimum performance

* Automation that moves with the audio data

» Support for Microsoft's WMA Pro (audio and video)

+ Muitiple time-lines and multiple VST directories

* VST System Link and TCP/IP networking

+ Unlimited Rewire 2 channels

+ Comprehensive MID! functionality

Nuendo 2.0
The solution is clear. The choice is now yours.

respective hofders. Alf specifications are subject to change wthout notice.
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Add video

services to

your audio
world

John Krogh's article, "Getting Started with Video,”
gives a great overview about what you'll need to get
into doing audio for picture. But once you're bitten by
the bug, you might want to go all the way and add video
production to your roster of audio services. It's one thing to
do a live recording of a band; it's something else to shoot a
video too, and put out the live recording on DVD.

There's also a healthy market for industria! videos, videos for
the web, and even productions for local events (civic, church,
school, etc.) where budgets don't allow a full-fledged video
crew. Of course, you can spend upteen zillions of dollars putting
together a video facility worthy of Hollywood, but if you just
want to see if video's for you, there are "prosumer” options
that produce surprisingly good results for under $1,000 — and
in some cases, much less.

Capturing video and “rendering” a final result is quite different
from working with audio, but the editing process is very similar.
You cut, copy, paste, and fade, just as with audio-only productions,
and even do processing — adjusting a clip’s contrast and
brightness isn’'t much different, at least conceptually, from
adjusting EQ. And hopefully, at the very least, you'll have a
great audio track.

Intrigued? Here's what you'll need.

1. VIDEO CAPTURE DEVICE
The best input device for a budget video studio is a DV (digital
video) camcorder, which typically records on 60 minute tapes
that cost under $10 each. Other formats aren’t as friendly if
you're just getting started..

Look for an [EEE-1394 (also called FireWire by Apple or i.link
by Sony) interface to transfer the video/audio stream into a
computer for editing. Also check that the camcorder supports
receiving video via |IEEE-1394, so you can save edited videos to
tape as a cost-effective backup method. Most modern video
editing software supports any current DV with an IEEE-1394 port.

|IEEE-1394-compatible camcorders can cost well under a
grand, and typically include niceties like digital zoom, and
some primitive effects (negative, posterize, sepia, etc.). More
expensive models have better picture quality, but for creating
CD-ROM or web videos, budget camcorders will do the job
(FYI, I've had very good luck with Panasonic products).

2. IEEE-1394 (FIREWIRE) COMPUTER INTERFACE
If you have a relatively new Mac, it comes not only with a
FireWire port, but also iMovie software — more than good
enough to get you started.

Although some Windows computers include IEEE-1394
ports, if not you can add a PCI card with multiple ports for under
$50 (more if there's decent bundled video editing software).
Make sure you get a card with an OHCl-compliant chip set
falmost all are, especially if they use a Texas Instruments chip

EQ OCTOBER 2003 www.egmag.com

The Budget Video Studio

by Craig RAnderton
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An industrial “kiosk” video for a convention has been brought into Sound
Forge so the soundtrack can be tweaked with level maximization — an
important consideration, given the noise levels at most conventions.

set); check the packaging. Don’t use an OS earlier than
Windows 98SE (XP or 2K is highly recommended), and follow any
card installation instructions to the letter. XP includes primitive
editing software, but it's less capable than iMovie.

Don't by fooled by the low cost of many available board/software
bundles — they provide the lion's share of the features needed
to create short videos.

3. THE COMPUTER

A good audio computer is probably good enough for video,
although video consumes about 200 MB of hard disk space per
minute, so you'll need a fast, high-capacity hard drive. | have a
removable drive bay, and when working with video, insert a hard
drive that's dedicated solely to video projects. For a more
portable solution, consider an external FireWire-compatible
external drive. For backup, a DVD+RW drive is great, but simply
copying data over to a second removable drive can be even
more convenient.

Projects often take a long time to turn into a finished video
because of a process called rendering. Your "mixes” have to be
re-written to disk, and writing that much data while processing
may take a while. Dual processing computers can help with
dual-aware video editing oftware (e.g., Sonic Foundry’s Vegas).

4. THE SOFTWARE

While there are some surprisingly useful sub-$100 programs,

budget software may have a limited number of audio and video

tracks, unlike programs like Premiere, Final Cut Pro, Vegas, etc.
Extra video tracks simplify cutting between scenes — like

inserting an audience “reaction” shots, or cutaway shots {e.g.,



a close-up on a single musician’s face). More audio tracks make
it easier to include narration, sound effects, sonic transitions,
etc. However, you can still do a lot with limited track counts, at
least with simple projects.

Different programs also vary in terms of feature set. For
example, you'll want titling (character generation), but some
programs limit you to basic text options, while other allow
motion — slow rolis, movement of text from one side of the
screen to the other, etc.

3D transitions are fun, like where a scene swings back like a
door, or seems to “shatter” before a new scene appears.
Crossfades, wipes (where a picture slides in over another), and
other types of transitions add spice to videos. Although you
want to avoid falling into the same syndrome as early
Macintosh desktop publishers ("I have 23,438 fonts, and I'm
going Lo use them all!”), tasteful use of transitions, effects, and
proper titling all make a project look more professional.

An important software feature is the ability to export, and to
a lesser degree import, multiple file formats. If you're producing
files for CD-ROMs, you want to be able to export movies as
QuickTime format (Apple’s standard, but used with Windows as
well) and/or AVI files (pretty much Windows-specific). MPEG

THE SOFTWARE BOUNCE

You can often export the audio stream separately from the
video, bring it into a digital audio editing program, and tweak
the audio with dynamics, equalization, effects, etc. Many of
these programs also include a video window (e.g., Spark, Peak,
Sound Forge, etc.). You may be able to import the entire video,
tweak the sound track while watching the video, then save the
whole mess back out again (see screenshot).

AND THAT’S IT!

Yes, it really is that simple. When | first added DV capabilities to
my studio (a $600 camera and $100 IEEE-1394 board with editing
software), | expected a learning curve and a bunch of problems.
Less than a week later, my first finished video was done, and
many more have followed. With the ever-decreasing costs of
video gear, there's never been a better time to add video
capabilities to your audio studio.

PRODUCTION NOTES
Doing the Shoot: In pro work, single-camera shoots are rare.
Multiple-camera shoots capture scenes from different angles;

is another useful export format. For streaming web work,
you'll want Windows Media (which is also being used more

for CD-ROMs) and RealVideo capabilities.

the video editor then assembles the best parts. if you're doing
a rock video, you can simulate a two-camera shoot by shooting
the same song multiple times from different angles. And don't »
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A Surround DAW Isn’t Enough

Realize the full potential of your DAW
with a MultiMAX EX surround monitor
controller. Work in LCRS, 5.1, 6.1, 7.1, and
more. Mix against multiple surround
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Monitor external processing. Adjust
monitor level. Mute, dim, solo and trim
four speaker systems. Get MultiMAX EX
and take your DAW to the MAX.
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Stop Shouting Through The Glass!

Wouldn't it be great if your stereo DAW
had talkback, cue and monitor control?
MonitorMAX empowers your standalone
workstation, adding console-like features.
Independent monitor and cue select for
ten stereo sources, separate level controls,
alternate speakers, optional integration
with MultiMAX, and of course, talkback.
Your only shouting will be for joy.
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Budget Video Studio

forget you can cheat: You can cut in face shots and audience
reactions from another song.

REMEMBER THE END RESULT: If you're shooting to
stream over the web, techniques like zooms, pans, and moving
backgrounds with small details wreak havoc with video data
compression algorithms. Edit using lots of relatively static

Full Sail's Suite 415 nne ot over 60 studios, production
suites, and computer labs located on campus

To find out why

fullsail.com
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If you're passionate about pursuing a
career in the recording industry,
Full Sail is the place to start

800.226.7625

shots rather than relying solely on motion to provide interest.

LIGHTING: CCD cameras (most video cameras) often pick up

line-like “streaks” when there are strong, narrow light sources,

such as stage lights. Other lighting probiems include reflections,

low light levels, and moving spotlights or brightly-lit objects that

throw off auto-focus — if a light strikes an object that's farther
or nearer than your subject, the camera
focuses on that. In this case, use man-
ual focus.

| RENDERING FOR THE WEB:
{ Data compression usually happens when
you “Save As.” For the web, common
formats are RealVideo (.RM), QuickTime
{.MOV), and Windows Media Video
{.WMV). Tradeoffs include size (bigger
screen sizes require more bandwidth);
frame rate (the more frames per second,
the greater the required bandwidth);
and audio quality. Although video is
| still viewable with huge amounts of
data compression, audio suffers when
you remove too much data.

As you get into video, save a file with
various options, open each one in your
media player, and judge the results of
the tradeoffs, including file size and
quality. This can take some time, but the
results are often worth it.

| RENDERING FOR CD-ROM:
Whatever codec (coder/decoder) you
use for compressing the video must be
present on the target computer. There is
currently no universal codec, although
Intel Indeo, Radius Cinepak, and Apple’s
various QuickTime codecs (e.g.,
Sorenson) come close. Saving as a
.MOV file using QuickTime is an excel-
lent choice because of the large per-
centage of Macs in the music industry,
QT's significant penetration into the
Windows world, and good compres-
sion quality. For Windows-only appli-
cations, saving as an .AVl file using
the Indeo or Cinepak codecs works
well, but more people are moving to
Windows Media because of the excel-
lent video performance despite high
amounts of compression. Saving as an
MPEG file combines small size and
high quality, but not all computers can
read MPEG files, and most budget video
programs aren’t really designed with
MPEG in mind.
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I like the ISA 428 very much indeed. It looks good, sounds
fantastic, is completely bombproof and is a joy to use. In Y “
terms of technical performance, the card at least equals —
and in most cases outperforms — other comparable converters.
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Video looks
better when

an

An interesting study noted that test subjects
looking at two identical videos felt the one with
better audio /ooked better. That's how important
audio is to video . . . and what gives us audio types a
big advantage when working on video projects.
| originally added video capabilities to my studio to do
streaming videos for MusicPlayer.com. But since then, I've
scored several video gigs from music industry companies that
can't justify the cost of a standard video production house.
Furthermore, some “video pros” are not up to speed on
music, and aren’t sure how to edit video so the audio
receives priority.

In this article, we’ll look at editing audio for a web-only
demo of Korg's Kaoss Entrancer, an audio/video processor
with real-time control. We'll concentrate on audio, but let’s
start out with a bit about the shoot, as it influenced how the
audio was handled in post-production.

THE SHOOT

The video was shot (using a Panasonic DV camera} in the Korg
booth at the Nashville Summer NAMM, before and after show
hours to avoid the crowds. James Bernard’s demo involved
manipulating the Entrancer’s controls to show how that affected
the audio and the video, which was projected on a large screen
behind him.

A three-camera shoot would have been ideal: one on James,
one getting a direct video feed from the screen, and one on
his hands working the box. As | was doing a single-camera
shoot, | got around this by taking lots of stills of the unit, as
well as shots of me moving knobs, flicking switches, etc. (|
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Track 5 is the main narration track; each vertical line represents a place
where material was removed to shorten the overall length.Track 4 has
the main video.Tracks 1, 2, and 3 contain text, still shots, and small
movies to cover over awkward video transitions. Track 6 contains intro
and outro music.
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Video

by Craig Anderton

didn't think anyone would notice they weren't James’ hands).
During the demo, | kept the camera on James but from time
to time moved to the screen behind him. If this caused an
awkward transition, the extra shots came in handy to cover
those transitions, as well as to cover up splice points where
the video was shortened.

After the demo, | shot James doing additional hand motions,
and some cool video processing on the screen behind him. The
video didn’t correlate to hand motions, but | never showed both
at the same time. While not a three-camera shoot, | had the
same elements as if it had been.

For audio, James' headset mic went into a mixer along
with the audio being processed and fed a pair of speakers. A
camcorder mic isn’t going to do the job, so | patched a MiniDisc
into the mixer's tape outputs, set levels, and was good to go.

When doing a shoot, record conservatively; give up a few dB
of signal-to-noise to avoid distortion. With mono sources, | often
record in stereo but pad one input down by -10 dB. If the primary
channel distorts, | can use the secondary channel’s signal.

MAKING TRACKS

When | got back to my studio, | booted up Vegas 4.0 (see the
review in this issue) and loaded all my video clips, with the
associated audio from the camcorder mic, into the program.

Next came the MiniDisc audio transfer. By comparing the
waveforms of the camcorder audio to the MD audio, | could line
them up visually, requiring no SMPTE or other sync. As the DV
camcorder and MD are crystal-controlled, drift is not an issue
unless you run more than 15-20 minutes or so.

However, you want them to stay locked even as you move
bits and pieces of audio and video around, so | grouped the MD
audio and video track together, while muting the camcorder
audio. Grouping means that if you, say, split the video, the
audio splits at the same point, and the two tracks move
together. Grouping is essential with lots of edits; you don't
want to accidentally move the audio independently of the
video, except in specific cases (e.g., you want to use a certain
bit of audio, but need a different picture).

EDITING NARRATION
With these types of projects | clean up details first, then deal
with bigger edits. This is because the company wanted three
minutes of video, so at least five minutes of footage had to
be cut,

So, | start at the beginning and listen to the audio. If there’s
a pause (or “uhh,” cough, etc.), | split the clip at the beginning
and end of the pause, delete it, then slide the clip after the
pause to the left so it butts up against where the pause used to
begin. This reduced the length to about four minutes.

After finding a few places where some features were
repeated, then eliminating the duplicates, the video clocked in
at just under three minutes (see screenshot).

DEALING WITH THE MUSIC
During much of the demo, James was talking over music. This
led to two major issues:

His voice would often be low compared to the music.
Cutting pieces of the voice track meant cutting the music
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Industrial Video

too, and splices had to be on the beat (or at least make musi-
cal sense).

The first problem was solved later by adding a lot of loudness
maximization to reduce level differences between the voice and
music, and boosting the EQ a bit in the speech range. The second
was trickier, but as James’ audio demo was loop-based, I'd find a
space where there wasn’t any voice, find another space that
happened at the same place in the loop, make the cuts, then
butt them together.

| also wanted background music for the intro and outro.
When shooting | always record a little extra demo music for this
purpose, which went at the beginning and end.

THE BIG MOVES

The audio track now had a lot of edits (I’'ve gone as high as 90 in
a three-minute video). | wanted to move some phrases around,
but it was getting cumbersome to select and move all those tiny
little pieces of audio and video. So, | rendered just the audio
track to a new file, then just the video,
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and re-imported them into the project to
replace the older tracks.

Now it was fairly simple to change the
order in which some of the features were
introduced. Once the audio editing was
finished, | re-rendered it one more time
to make a file suitable for importing into
a digital audio editing program.

AUDIO EDITING TWEAKS

Vegas is decent for audio editing, but isn't
quite as capable as a dedicated two-track
digital audio editor. So, | loaded the file
into Wavelab and went to work.

Many of these edits used the tech-
niques discussed in last month's issue on
processing vocals: using low-cut filters to
reduce popping, noise reduction to remove
any overall hiss, cutting out cable or mi¢
noise, and phrase-by-phrase normalization
for consistent audio levels.

| also added loudness maximization and
EQ for the entire track. Once the processing
was done, it was time to save, then go back
to Vagas and re-load the finished audio.

THE FINAL TOUCH

With the audio track complete, | covered
over the last of the awkward transitions
with other shots done earlier, or slides
containing text that highlighted specific
features. Now al! that was left was to
render the final product.

As this video was for the web, rendering
can make or break the project. In this
case the client wanted both Windows
Media and Real-compatible files. The
toughest part was deciding how to
apportion bandwidth between audio and
video. In previous projects, audio always
had priority over video, but in this case,
the demo was of an audio and video
product, so the balance had to be just
right {see sidebar]).

After rendering for broadband and
dial-up formats, the project was done.
Considering all the years | spent doing
video with two buiky tape machines
going through a switcher to “mix down”
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the video to a third machine (can you say “generation loss”?),
computer-based video/audio editing has been a tremendous

boon to my project studio.

THE ART OF DATA COMPRESSION !
Because audio and video devour bandwidth, data compression

is essential for streamed material.

The three main data-compressed formats for the web

1 he Choice of Fhase Wha Can Hear The Differeace

Video

are Windows Media Video, RealVideo, and QuickTime. Each
uses a specific codec to perform the compression, and the

target computer must have the same codec with which the
file was compressed. Both Windows and the Mac 0S include

playback codecs as part of the operating system, so pro-
grams that compress data typically use these codecs.

QuickTime isn't really a codec, but a "container” for files
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that use a certain codec. Compressing to the Real format guar-

antees that a Real media player can
play back the file.

For Windows, Windows Media 9
does great compression, but WM7 or
WMS are good too. For Windows
Media, QuickTime, or Real, if you call
up a video while online and the appro-
priate codec isn't availahle, the com-
puter will usually connect to the web
and download the required one.

Broadband data rates range from
128 to 256 kbps (kilobytes per sec-
ond), but subtract about 10-20% to
account for net congestion, as often
happens with DSL. You have to decide
what amount of bandwidth to appor-
tion to video and audio. Here are a
few tips:

M Mono saves more bandwidth than
stereo.

B 32 kHz sampling rate is usually
fine. For voice only, even 8 kHz can
work.

M Save several variations and com-
pare. For example, 32 kHz/mono
requires 20 kbps, with the remain-
der available for video. But if the
video is jerky, try 22 kHz/mono.

B Many programs try to simplify the
process by giving “presets” for spe-
cific baud rates and qualities. These
are excellent points of departure,
but you can usually tweak them for
your specific application.

M For compressing QuickTime audio,
| like the QDesign Music 2 codec.

| If you need more bandwidth for
audio, reduce the video frame size
and/or frame rate.

Compressing for dial-up requires
a data rate of around 35-40 kbps,
and involves serious tradeolfs. To free
up 5 to 8 kbps for the audio, use a
tiny frame size (| generally use 180 x
120) and a low frame rate, like 10
frames petr second. it won't look
great, but it should stream over a 56
kbps modem.
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Audio for T
Behind the
scenes of a
45-second spot

Over the past four years |'ve composed music
and created sound design for a commercial music
house. When | first started, | had no experience

working with video — | knew how to find my
sequencer’'s SMPTE sync functions and that was about

it. Since then, |I've become quite comfortable working
with video in my music studio. Initially there were basic

setup and workflow issues that | had to become familiar
with, but once | did, | was able to work quickly in my studio,
composing music and creating sound design for a number of
national and regional commercials, or spots, as they're called
in advertising circles.

To give you an idea of how it all fits together — video clips,
synchronization, audio tracks, and so on — I'll break down a
recent :45 (45 second) spot. The steps | cover here are the same
for just about every project | work on, so after reading you should
have a solid nuts-and-bolts understanding of what'’s involved in
the audio-for-video world as it relates to TV advertising.

GETTING THE SPOT
I've been working exclusively with digitized video for a year now
because of the convenience and “recallabiltiy.” Much of the ad
world is still holding on to tape formats, though, so when | am
sent a tape — be it 3/4° or a 1/2° (VHS) — the first thing 1 do is
capture the spot(s) into my computer via a FireWire DV breakout
box {Miglia’s Director's Cut, www.miglia.com). Fortunately,
more and more producers and video editors are working with
digital clips, and in the case of my :45, the edit/post-production
house gave me online access to their client server, which
contained the digitized commercial.

This file had a “temp” music track — a sort of guide that
illustrated the musical direction for the spot. Temp music and

V Commercials
by John Krogh @llﬂk

placeholder sound effects are used all the time — they can help
move the project along more quickly, as it takes some of the
guesswork out of the equation. In this case, the director liked
the temp track, but the producer didn't feel it had enough
drama; it wasn't quite right.

| wanted to have the temp track available for reference in my
sequencer, which meant I'd need to extract the audio from the
clip. To do this | typically use QuickTime Pro, which lets you
export to a variety of formats, including AIFF (see Figure 1)

DAW SETUP

Next | opened a new song session, imported the audio, and set
the session's frame rate to 29.97 — the rate used for TV in the
States. Then | opened the video clip, which | trimmed so it started
at frame one. However, when | played it back from within Logic
Audio, the movie was jerky — this was because the edit house
had given me a clip saved in MPEG-1 format, which isn't as
“friendly” with Logic as other formats.

| went back to QuickTime, opened the clip and exported it
as a QuickTime movie with the Sorensen Video codec (see
Figure 2). | know from experience that this results in smoother
playback, although picture quality might not be as crisp. This
didn’'t matter — | wanted to hit certain cuts and onscreen
action, so smooth playback was more important.

| reopened the Logic file, then opened the movie: | was now
ready to line up the beginning of the movie with the downbeat
in my session. Because | trimmed the movie to start on frame
one, it was easy to set this up.

With video files that aren’t trimmed, assigning a bar to
play at a specific SMPTE time {e.g., the beginning of the clip}
often involves the additional step of assigning the movie start
time. Why is this necessary? Because it's not uncommon for
video clips to start somewhere before the beginning of the
commercial. Exactly where isn't immediately clear. Maybe the
person who prepared the video file arbitrarily trimmed it, or
whatever. This is where having timecode burned onto the
video can be useful {see Figure 3). »

Movie to AVI Default Settings
Movie to BMP = Save Me! Most Recent Settings
Movi § adidasv2.dv Eect Streaming 20kbps - Music = High Motion
e to DV Stream | adidasV2.mov b2 = Streaming 20kbps - Music - Low Motion
Movie to FLC § adidasv2pl Desktop Streaming 20kbps - Voice - High Motion
Movie to Hinted Movie | adidasv2 highmtnmov B CRewl ) Streaming 20kbps - Voice - Low Mation
Movie to Image Sequence | adidasV2_soren.maov ‘ = = Streaming 40kbps - Music - High Motion
| baseball6G.mpg Streaming 40kbps - Music - Low Motion
Movie to MPEG 2 foothaRb0.dv = Streaming 40kbps - Voice - High Motion
Movie to MPEG-4 -4 _ Streaming 40kbps - Voice - Low Motion
Movie to Picture Save exported file as: Streaming 100kbps - Music - High Motion
Movie to QuickTime Media Link | adidasv2.mov ] l Save l Streaming 100kbps - Music - Low Motion
Movie to ickTi Movi Streaming 100kbps - Voice - High Motion
4 e w cklime e Streaming 100kbps -Vou:g - Low Motion
Movie to Toast Video (D FXN'E [ Movie to QuickTime Movie 3] Streaming 20kbps - Music
Use: [ 2x CD-ROM (Sorenson video) / SUSHNSY Mty « Taea
Sound to System 7 Sound Streaming 40kbps - Music (mono)
Sound to Wave Fig. 2.The MPEG-1 movie cip didn't play smoothly f1om | surcaming 40kts < Vaiee |
Sound to plaw my host program, so | exported it from QuickTime Pro
using the Sorenson Video codec. This resulted in a onson )
Fig. 1. QuickTime Pro lets you export/extract  smaller clip that played back properly in Logic. Note: = = SAUFEDS MRS}
the audio from a movie clip for use within  QuickTime Player doesn’t give you the option of 1x CD-ROM (Cinepak video)
a DAW. exporting — this is only available with QuickTime Pro. 2x CD-ROM (Cinepak video
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Audio for TV Commercials

From looking at timecode
on the video, you can tell
where the clip actually
starts (in SMPTE frames).
Once you set this SMPTE
location as the movie start
time, your sequencer’s
counter will match the
timecode on the video.

Even though | had bar
one of my session starting
in sync with the beginning
of the commercial, | hadn't
yet determined the tempo
I'd be working at, so none
of the subsequent barlines
lined up with any of the
action. The solution was

Fig. 3. This movie clip has timecode
“burned” onscreen (top center).
This is sometimes called “window
dub” — having timecode onscreen
is helpful for locating hit points
and trimming the clip so it starts on
frame one of the video.

Fig. 4.1've zoomed in on an audio region that I'd like to place at a specific
SMPTE time. By scrubbing along Logic's timeline, | can find the exact spot,
then move the audio to this location.

simple: Because the spot

was cut to a temp track,
all | had to do was find the
tempo of that track.

Every major DAW has a way to determine tempo from audio;
in Logic this involved using the sample editor to create a 2-bar
clip of the music. By telling Logic the clip is two bars in length,
the sequencer could then calculate tempo. (Other programs
may work differently.) At this point, barlines were hitting specific
cuts and action, so | was ready to start creating the music and
sound design.

Hint: Make a blank song template that has the SMPTE/bar
assignment {e.g., "SMPTE time of one hour starts at bar 2")
saved into the file. That way you can simply open a copy of the
template, load the trimmed movie, and go — you won't have to
monkey with the SMPTE/bar assignment.

CREATING AUDIO CONTENT

For me this usually means composing music and sometimes
creating sound effects (not Foley or field recorded sounds).
Occasionally I'll record voice-overs, but for most of the projects
I'm involved with, VOs are usually done somewhere else.

Our focus isn't on composing, so | won't go into detail
about how | programmed and recorded my music. But there
are some general video issues worth mentioning, such as hit
points. There were several places in the :45 spot where |
wanted to "hit” certain movements — when the main character
starts unzipping his jacket and pulling out his shoes, for example.
This wasn't a moment that needed to fall on a beat, but |
wanted to add a subtle sound design element to slightly
emphasize what was going on. The action wasn't hitting with
any beats, so | decided to scrub the timeline to locate precisely
when each motion was happening (in SMPTE time). See
Figure 4.

This is a technigue that you'll use often if you do a lot of
sound design. Basically, you scrub along the sequencer’s timeline,
locating specific SMPTE times, then move the sound effect
audio region to that particular location. Logic has a key command
function — Pickup Clock (Move Event to SPL Position) — designed
for this purpose, which will automatically move an event (MIDI or
audio region) to the song position play bar.
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The remaining composition work took a couple of days and
included live tracking of acoustic guitars, percussion, and
Wurlitzer electric piano. With the music finished, it was time to
prep it for delivery.

FINALIZING & DELIVERY

What you deliver to your client depends on the scope of the
project. For small projects, you may only have to provide a
single "TV mastered” audio track. On larger projects you'll
likely be required to send a stereo mix, along with individual files
of just guitar, bass, drums, synths, etc. (These are commonly
referred to as splits.) In some cases you may be asked to
deliver the audio on DAT, but more often than not a CD-ROM
is preferred.

A note about prepping the files: You can’t just bounce your
music and hand it off; what if the music doesn’t start exactly at
the beginning of the commercial? Maybe it's supposed to start
5.27 seconds after the first frame — how will the video editor
know where to place your track? To ensure things will line up
properly, a short "beep” called a 2-pop is placed precisely two
seconds before frame one. When you bounce your tracks,
include the 2-pop. That way, the editor can easily put the audio
in the right location by placing the beep two seconds prior to
the commercial’s start time.

When you're finished outputting all the necessary audio clips
(or tracks, if you use DAT), they'll be sent to a post production
facility where your audio gets added to a master session containing
any additional sound design or narration.

In the case of my :45, | was covering all audio duties, and |
knew the video editor had online access, so | chose to post the
finished music on a secure server rather than send it to him on
CD-ROM. He downloaded the clip, lined it up with picture, and
that was that.

For the purpose of this article | added my final audio to the
low-res video clip | used in Logic. If you'd like to check it out,
you can see and hear the spot by going to www.egmag.com.
And if you have any questions, feel free to email me at
jkrogh@musicplayer.com.
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Scoring
to picture

If all this talk of AV-production has
your mouth watering, the following
crash courses will get you pointed in the

right direction. Whether you use Digital
Performer, Logic, Nuendo, Pro Tools,
Samplitude, Sequoia, or Sonar, here's how you
can import a Quicktime, MPG, and/or AVI movie into
your DAW and create a hit-point/marker track to match.

CAKEWALK SONAR
Sonar will load an AVI, MOV, or
MPG (MPEG) format video,
whioh then shows up in a
video window. As you change
the Now time, the video fol-
lows along.
Opening a Movie

Go File > Import > Video
File. Navigate to the desired
video file, select it, then click
on Open You can optionally
import the audio stream that's
part of the video (select a
blank track before you do this),
split the audio file into two
separate tracks instead of a

single stereo track, and show
the file info.

If you can’t open QuickTime (MOV) files, obtain current
QuickTime codecs by going to www.microsoft.com and down-
loading the latest version of Media Player.

After Sonar loads the video, it shows up in a separate
video window. If this is the active window, you can use the right
and left arrow buttons to move forward or backward respectively
by single frames. Ctrl-right arrow and Ctrl-left arrow moves the
frame increment value by five frames at a time.

Offsetting Audio & Video

When you right-click on the video window and select
Properties, with AV| files you can set the video start time. This
is referenced to bar/beats/clocks on the assumption that you
will want it to start at a specific point in a piece of music. (As
you can change the timeline calibrations at any time, you can
switch over to SMPTE if you're spotting sound effects at specific
times in addition to doing music.)

You can also set trim-in/trim-out times (the offset into the
video at which playback begins and ends, respectively) using
SMPTE values. For example, if you're scoring a section that
occurs 27 minutes, 12 seconds, and 4 frames into the video,
you can set the video to start playback at that point when you
start from the beginning of the music.

More Property Page Options

The Info tab shows details on the video, including current
frame, image size (original and current), etc. The More button
brings up additional data on quality management info (frames
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Power App How-To:

compiled by Greg Rule

dropped in renderer, jitter, average frame rate achieved, and
the like). The Render Quality tab lets you enable a Preview
Mode that degrades video gquality somewhat but gives
smoother playback. Here you can also change the frame rate
and video size (in pixels).

Optimizing the Display

Click on the float icon in the upper left corner and check
Enable Floating if you want to float the video window over to
a second display. There are also several ways to optimize the
display.

Stretch Options include Set Video To Original Size, Stretch
To the Current Window Size, or Full Screen. It's also possible
to preserve the aspect ratio, and stretch by integral
multiples of the original frame size.

Time Display Format can be Measures/Beats/Ticks,
SMPTE, Frames, or None. This is also where you can
also set the font and color for the time readout in the
video window.

Background Color is selectable between white
or black.

Using Markers

Markers are useful for creating “hit points” for
events (e.g., sound effects) that need to correspond
to the video. These are usually locked to SMPTE, so
even if you make tempo changes in the music, the
markers stay at their assigned positions with respect
to the video.

To access the Markers toolbar, go View >
Toolbars and check Markers. The toolbar can be floated
or docked.

Although there are several ways to add markers
in real time while watching the video, the simplest
method is to press F11, or click on the toolbar’s Add Marker
icon (the marker symbol with the + sign). Markers are placed
without regard to the Snap grid, but if you move or copy them,
they can optionally snap to the selected grid value.

If you hit F11 or Add Marker while the transport is
stopped, a dialog box appears where you can name the marker,
choose whether to lock it to SMPTE, and adjust its placement.
You can call up this dialog box for a previously placed marker by
right-clicking on the marker, regardless of whether or not the
transport is playing.

There are several ways to jump to particular markers, but
probably the easiest method when adding effects to a video is
to hit F5 twice; a Markers View shows up with not just the
markers you placed, but default markers for beginning, end,
punch in, punch out, loop start, loop end, etc. To jump to one of
these markers, double-click on the desired Marker, and click OK
when the Go box appears.

The final marker feature is the Markers List. This manages
markers, and compiles a list of all the markers you've created
Here you can delete or add markers (the Add Marker dialog box
comes up when you click on the New Marker icon), or Lock a
marker or group of markers by clicking on the Lock icon. It's also
possible to print this list so you can document where sound
effects fall in your video project.

In addition to navigation, markers serve one other pur-
pose: Clicking between any two markers in the strip just above
the timeline causes them to define a time range. This can be



useful data in deciding what tempo to use that encompasses
the maximum number of hit points, but Sonar does not do
this automatically.

Saving & Exporting

Note that video data is not saved as part of a bundle file.
The project references the video file, which must be backed
up separately.

After finishing your work, you can export the completed
audio/video file in AVI format only. Recommended video
codecs are Indeo Video 5.04, Intel 1.263, Cinepak, Microsoft
Video 1, and Microsoft RLE. Recommended audio codecs are
CCITT A Law, CCITT U Law, DSP Group TrueSpeech, PCM
{uncompressed WAV file), GSM 6.10, and IMA ADPCM.

Exporting is also where you specify the number of
keyframes. If you plan to do a lot of seeking and editing
around a video file, more keyframes (e.g., a value under 5)
makes the process faster. If you're working on a video that
has few keyframes, you can export it with more keyframes,
then re-import it into your project to speed up the workflow.
—Craig Anderton

DIGIDESIGN PRO TOOLS 6
The following procedures apply to h’
Pro Tools 6.1 TDM or Pro Tools 6.1
LE (with DV Toolkit option). }
importing a Movie b
Before you import a movie or A
video clip, set the frame rate of v
your Pro Tools session to match the
frame rate of the material you want
to import.
Set the frame rate:
Choose Windows > Show
Session Setup.
Choose the frame rate from
the Frame Rate pop-up menu.
Import a QuickTime movie or

~
A
)
P
vV
~
v

Choose Windows > Show Session Setup.

Enter a new value in the Session Start field (for example,
01:00:00:00)

Spot a Movie to a Location

Put Pro Tools in Spot mode.

Using the Grabber, click the movie in the Movie track.

Enter the start time for the movie and click OK.

Viewing QuickTime DV Movies via FireWire

Using a compatible digital video converter, you can play
imported QuickTime DV movies through your computer’s
FireWire port, and view them on an external video display.

Play Back a QuickTime DV Movie through the FireWire
port

Import a QuickTime DV-format movie into a Pro Tools
session.

Choose Movie > Play DV Movie Out FireWire Port.

Begin playback.

Spotting Audio To a Movie

You can use Grid mode to constrain the movement of audio
regions to the grid in the Edit window. You can also manually
identify hit points and tempo events in the session and use
those to spot audio regions.

Using Grid Mode to Spot Audio

You can spot audio regions to precise
SMPTE or frame locations in the timeline.

Spotting an audio region

Set the main time scale to Time Code
or Feet+Frames by clicking the corresponding
name in the Edit window Ruler.

Put Pro Tools in Grid mode.

Click an audio region in the timeline, or
drag a region from the Audio Regions List.

Enter the location for the region and
click OK.

The beginning of the region (or its
sync point, if one is defined) is placed at the
specified location.

Identifying Hit Points in a Session

~

AV clip: You can use Memory Locations to drop
Choose Movie > Import markers in a session while the session is
Movie. playing back.
Select the movie and click Open. To manually drop a marker in a Pro Tools session during
The movie is displayed in a new Movie track in the Edit playback:

window and in a floating Movie window. The first frame of the
movie is automatically placed at the start time of the session.

If there is audio associated with the movie, you can import
that audio for editing or for use as a guide track.

Import the audio from the QuickTime movie or AVI clip:
Choose Movie > Import Audio From Current Movie.
Select the tracks you want to import and click OK.
Choose the destination for the imported audio.

The imported audio is converted to the session’s bit resolu-
tion and sample rate, and appears as a new region in the
Audio Regions List, which you can drag into a track in the
Edit window.

Adjusting the Movie Start Time

You can adjust the start time of the entire Pro Tools session
to match the start time of the material you imported, or you can
spot the movie to any location within the session.

Display the Edit window.
Press the spacebar to begin playback.
When the cursor reaches the desired location, press the
Enter key on the numeric keypad.
Under Time Properties, choose Absolute for the Time
Reference.
Enter a name for the marker and click OK.
You can later move the markers to any location by dragging
them in the Ruler.
Calculating Tempo for a Scene
You can select any part of a session (such as between two
hit points) and get Pro Tools to automatically calculate a steady
tempo for that selection.
To assign a tempo and meter to a selection:
In the Edit window, select a partion of the session.
Choose Edit > Identify Beat. »
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Enter the bar and beat numbers you want to assign to the
beginning and end of the selection.

Enter the time signature you want to assign to the
selection, and click OK.

Meter and Tempo markers appear in the Ruler, and the Bar and
Beat grid reflects the new tempo and meter for the selection.
You can then spot audio regions to the new grid.

Importing a Tempo Map

You can import a tempo map as a Standard MIDI file (from

another Pro Tools session or any other sequence) and use it in
the current session to conform a music cue.
To Import a MIDI File and use its tempo map in the current
session:
Choose File > Import MIDI to Track.
Choose the MIDI file you want to import.
Select Import Tempo From MIDI File.
Click Open.
The tempo map from the imported file appears in the ses-
sion’s Ruler.

42
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Conforming Audio to the Grid

The Time Compression/Expansion
Trimmer in Pro Tools lets you adjust an
audio region (for example, background
sounds or a drum loop) to fit a scene or
selection. —Tom Dambly

EMAGIC LOGIC AUDIO
You can have QuickTime movies runin a
Logic window in sync with a song.
Wherever you move the song position the
film follows, and vice versa.
Opening a Movie
Select Options > Movie in the
Arrange window to open a typical file
selection box. You can then select a
QuickTime movie from your hard disk.
If you select Options > Movie As
Float you can open a QuickTime movie in
a float window. That way the movie will
always stay on top.
Reopening a Window
The Key Command, Open Movie
Again, reopens a movie window with the
same film. This is particularly useful if you
wish to open the film in a different
screenset.
Working with Movies
In the QuickTime window, you can
enter the SMPTE offset of the film at the
bottom (the Movie Start). This is inde-
pendent of the SMPTE offset for the
song. By grabbing and dragging the posi-
tion slider at the bottom of the picture,
or by using the forward/rewind buttons
to the right, you can move the film to
any position, and Logic will jump to cor-
responding song position. All the
QuickTime transport functions interact
with those of Logic.
Optimal Image Size
If you click once on the video image,
the QuickTime movie will expand to fill
the whole screen in such a way that the
entire video image, whatever its shape,
will fit your monitor. The window bor-
ders will also disappear (best size with-
out borders). Clicking on the image




restores it to its original format.
Synchronizing Methods
The Contiguous Sync option allows
you to switch between the following
sync methods:

When Contiguous Sync is
turned on, Logic controls the playback
speed of the movie, so as to keep
music and pictures in sync at all
times. If the film has a soundtrack,
the audio signal will be transposed
slightly, if necessary, by means of
sample rate conversion.

The sync method is possibly
more precise, but requires greater
processing power. Movie Drop Sync

DV Playback via FireWire

Quicktime movies in DV format can be
output from your Logic song to a FireWire
device. For technical reasons, only QuickTime
movies in DV format are supported.

You can easily activate this option by
selecting FireWire as the DV Output option
in the Song Settings > Video menu (your
FireWire DV device must be connected at
the time}. You can also access this prefer-
ence by opening your QuickTime movie as
usual and then holding the mouse button
down in the movie window, which brings up
the QuickTime options pop-up menu.

Video Thumbnail Track

The Video Thumbnail Track is a special

(with Contiguous Sync switched off}

track class in Arrange, which displays the

means the QuickTime movie will be shown at its original loaded Quicktime movie as thumbnails on an Arrange Track. You
speed. If any time corrections need to be made, do so by select this track class from the hierarchical menu of track classes.
repeating frames or omitting them. If there is a soundtrack, a The number of thumbnails you see depends on the current
quiet click will be heard at this point. This method is also usu- zoom level. —Christine Withelmy

ally reasonably accurate.
Video to Song Adjust

Found under Option > Settings, this global setting will MAGIX SAMPLITUDE & SEQUOIA

fine-tune the starting point of the movie.

Both Samplitude and Seqouia use Windows Media Link to play

NEWSFLASH!

WODZ0G'MMM

The SoundShuttle Plugin is here!

The SoundShuttle is the world’s first internet based library of
loops and sound effects available directly into your sequencer
as a software plugin. Visit www.powerfx.com for more info.

Audition thousands of loops, samples
and sound effects right from within your
sequencer. The SoundShuttle utilizes

W YECHNICAL INFORMATION

gives you the possibility to find sounds,
listen, try them in your arrangement,
buy and downioad - instantly. Take the

your sequencer’s plugin architecture to guesswork out of loop & sound effects Acid, Loglc, Gubase, Projact 5. Ableton LIVE.
connect directly to the PowerFX online purchases with the ultimate sound Final Cut Pro 4, Pro Tools and MOTUY,
library. This extensive search function selection software.
ABOUT POWER FX®» PowerfX. A leading sound d and provider sp g in sampling products and sound effects for today's sound production projects.

POWER FX SYSTEMS AB

ADDRESS »

TEL » FAX »

WEE » EMAIL »
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back AVI and MOV videos,
as well as any other files
(WMV, MXV, MPG, etc.)
that have an MCI driver
installed in Windows.
(Note: This feature can
also link MIDI Files with a
project.} Videos can play
back in a separate video
window, and show up as a
track with thumbnails. This
example will be based on
Sequoia; Samplitude oper-
ates almost identically.

Opening a Movie

Go Options >

Project Options > Media

processor-intensive audio operations.

Correction Factor for Exact Positioning will not
need to be used with most modern computer systems.
With slower systems where the audio runs ahead of or
behind the video, you can enter a correction factor
here so the two play in sync.

Video Options
A separate section for Video Options controls how
video interacts with the program. The options are:

Extract Audio from Video strips the audio from the
video and places it in the current project, where it can
be edited. The video still appears.

Replace Audio in Video bounces your current pro-
ject to a WAV file, and merges it with the AVi track.
After selecting this option, an additional dialog box
appears that lets you determine whether this replaces
the audio in the original AVI file, or saves the result as a

Link. Browse for the
video to bring into the program (click on the folder icon),
select it, and click Open. If you're not sure whether it is the
correct video file, click Preview;, the video will play in its video
window. Click Preview again to stop. You can also remove the
Media Link by clicking Remove Link.

Show Actual Video Frames, when checked, shows the
current frame in the upper left corner of a VIP project. Show
Video Track places a track of thumbnail images above the time-
line. Zoom in far enough, and you'll see individual frames.

Alternatively, you can just drag the video file into the
timeline. The program will open the windows Show Actual
Video Frames and Show Video Track automatically.

As with other Windows programs, if you can’t open
QuickTime (MOV) files, obtain current QuickTime codecs by going
to www.microsoft.com and downloading the lat-
est version of Media Player.

Media Link Options
The Media Link window offers several
other options, such as:

SMPTE Offset allows setting a separate
start time for the media file. Usually it lines up
so the video and audio start at 00:00:00:00;
the offset you enter specifies the time in the
media file that corresponds to the audio’s
start point.

Play Files Always can be unchecked to
turn oft the video if playing the video affects
performance adversely, and be turned back on
when you need to check the project against
the video.

Load File Always New, when checked,
loads the video into your project. If unchecked,
the file plays back from memory, or, if it's too
large, is streamed from hard disk.

new AV file. You can also specify the audio format in
this box.

Play Video without Sound mutes the existing soundtrack
for any AVI file loaded into the project.

Video in Sequoia Window places the video in a window
that is always "on top” of the current project.

Optimizing the Display

You can resize the video window, but the aspect ratio is
not preserved, and there is no way to insure that it is. However,
you can right-click on the video window and choose from sever-
al sizes: original size, double, half, and one-quarter.

Use the right and left arrow buttons to move forward or
backward through both the video and the project by single
frames. (If you want to calibrate the timeline in frames, right-
click on it and select SMPTE.) —Craig Anderton

MOTU DIGITAL PERFORMER 4
Importing QuickTime or DV-format-
ted Video Clips

Choose Movie from the
Project menu.

Make sure the DP project
frame rate matches the imported
movie. If the movies were digitized
at, say, 30 frames per second (fps),
choose Setup > Frame Rate > 30
fps. This is a crucial step. It's
important to match the clip’s frame
rate, especially with 29.97 fps drop
and non-drop video rates.

Set the movie start time and
sequence start time. Most often,
digitized film cues are supplied with
a timecode start frame. Some cues

Synchronization to Audio Playback syncs
the video to the project, rather than doing “free sync” (although
free syncing works fine for shorter videos and demands fewer
system resources).

Prioritize Video Play gives more resources to the video
than the audio. Check this box when “proofing” the audio
against the video; uncheck it while recording and doing
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might start at frame zero
(0:00:00:00), for example, while others might have irregular start
times such as 2:13:37:05. To set the movie start time, choose
Set Movie Start Time from the Movie window mini-menu. This
ensures that DP’s markers and hit points accurately match the
frame times used by the film's sound effects editors and
music editors.



To set the sequence start time, click
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